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Copyright

This manual is copyrighted by Canon Computer Systems, Inc. (CCSI) with all rights reserved.
Under the copyright laws, this manual may not be reproduced in any form, in whole or part,
without prior written consent of CCSI.

©1999 Canon Computer Systems, Inc.

Disclaimer

Canon Computer Systems, Inc. has reviewed this manual thoroughly in order to make it an easy
to use guide for your Canon MultiPASS C530/C560 Desktop Manager system. All statements,
technical information, and recommendations in this guide and in any guides or related
documents are believed reliable, but the accuracy and completeness thereof are not guaranteed
or warranted, and they are not intended to be, nor should they be understood to be,
representations or warranties concerning the products described.

Your MultiPASS and the software media included with your system have been sold to you
subject to the limited warranties set forth in the warranty and license agreement enclosed with
the respective products. All software is licensed AS IS, as described in the license agreement
enclosed with the software media. Further, CCSI reserves the right to make changes in the
specifications of the products described in this guide at any time without notice and without
obligation to notify any person of such changes.
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All other product and brand names are registered trademarks, trademarks or service marks of
their respective owners.

ENERGY STAR® COMPLIANT

As an ENERGY STAR® Partner, Canon U.S.A., Inc. has determined that this product meets the
ENERGY STAR® guidelines for energy efficiency.
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Chapter 1
Introduction

With your MultiPASS C530/C560, the Desktop Manager software package enables you to
perform a variety of tasks, meeting all your printing, faxing, and scanning needs.

❑ Desktop Manager Features: An Overview ..........................................................................1-2
❑ The MultiPASS Settings .......................................................................................................1-4
❑ Desktop Manager Software Package ...................................................................................1-5
❑ Using Your Documentation ................................................................................................1-7

● About This Guide .........................................................................................................1-8
● Conventions Used in This Guide ................................................................................1-8
● Other User Assistance ..................................................................................................1-9

❑ Using the MultiPASS Toolbar ............................................................................................1-10
● Changing the Options for the Scan Buttons on the Toolbar ...................................1-14
● Changing Toolbar Settings ........................................................................................1-19
● Performing Other Toolbar Tasks ...............................................................................1-22
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Desktop Manager Features: An Overview
This section reviews some of the features of the Desktop Manager. For detailed information and
instructions, refer to later chapters in this guide.

■ Print a Document
The MultiPASS can be configured as the Windows® default printer, allowing you to print a
document in any Windows application. You can also define and customize print options
that affect the output of your printed documents. For information on printing with the
MultiPASS, see your online User’s Manual.

■ Fax a Document
You can fax a black and white document from your computer, from within a Windows
application, or from the Desktop Manager. You can attach a fax cover page and even
schedule the transmission time that the fax should be sent. Predefined fax cover pages are
available for you to use, or you can design your own.

For associates to whom you repeatedly send faxes or e-mail, you can set up an Address
Book, containing predefined fax and e-mail information for each recipient (such as the fax
number or e-mail address). When you send a fax or an e-mail message from your
computer, the recipient information is then readily available in the Address Book.

You can also receive color and black and white faxes from your business and personal
contacts directly into your PC.
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■ Scan an Image
The TWAIN-compliant scan driver enables you to use the MultiPASS to scan black and white,
and color documents, photographs, and other images directly into the Desktop Manager or into
another Windows application.

■ Import or Export a Document
You can import, export, store, and manage documents and images in a variety of formats
directly in the Desktop Manager, such as .BMP and .TIF.

■ Manipulate or Annotate a Document
You can manipulate or annotate any document placed in the Desktop Manager — which occurs
by sending or receiving a fax, scanning an image, or importing a file. You manipulate a
document by scrolling through and viewing its contents; removing a page; splitting or merging
it with another document; editing it by cropping, rotating or flipping; adjusting the document
brightness, contrast, size, or image type; or by printing the document. You annotate a document
by adding a text annotation, graphic or text stamp, sticky note, highlighting, or by creating a
simple drawn graphic.

■ Set MultiPASS Options
Options that affect certain operations of your MultiPASS can be set manually on the MultiPASS
itself or in the Desktop Manager. These options include parameters that affect sending and
receiving faxes, and the assignment of speed dial numbers. Option settings defined in the
Desktop Manager override any corresponding option setting you previously set up on the
MultiPASS itself.



Chapter 1 Introduction    1-4

The MultiPASS Settings
To customize the MultiPASS to your particular needs, you can adjust the general operation,
sending, receiving, printing, system settings, and speed dialing settings. There are two methods
of adjusting these settings:

Method 1: Using the MultiPASS Desktop Manager
You can adjust settings using the MultiPASS Desktop Manager software included with your
MultiPASS. For detailed instructions refer to Chapter 6, Utilities, in this guide.

Method 2: Using the MultiPASS operation panel
You can also adjust settings directly via the operation panel of the MultiPASS. Detailed
instructions are described in the Stand-alone Fax Manual. Adjusting settings through the
operation panel is convenient when you do not have your MultiPASS connected to a PC.

Before adjusting any settings, decide whether you prefer to make changes from the MultiPASS
Desktop Manager or from the operation panel. Using both — the MultiPASS Desktop Manager
and the operation panel — may cause confusion. Changes made in the MultiPASS Desktop
Manager will override any corresponding settings made through the operation panel, and
changes made to settings through the operation panel will not be displayed in the MultiPASS
Desktop Manager.

n
If your MultiPASS is connected to a PC, we recommend using the MultiPASS Desktop Manager
to adjust any settings. If you are not using the MultiPASS Desktop Manager, you can ignore the
information in this manual.
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Desktop Manager Software Package
The Desktop Manager software package includes drivers and a set of utility programs which are
automatically installed on your system when you install the software package. The drivers allow
the MultiPASS to communicate with the software on your computer.

The following drivers and application programs are installed:

■ MultiPASS Desktop Manager for Windows
The MultiPASS Desktop Manager for Windows coordinates sending faxes directly from
your computer (PC faxes), receiving faxes into your computer, and scanning images. The
Desktop Manager enables you to store and manage the resulting documents.

■ MultiPASS Printer Driver
The MultiPASS printer driver enables you to use the MultiPASS as the default printer in
any Windows application that supports printing.

■ MultiPASS Fax Driver
The MultiPASS fax driver enables you to send a PC fax from any Windows application that
allows faxing.

■ Scan Driver (ScanGear™ for MultiPASS)
The scan driver enables you to scan an image into the Desktop Manager or most Windows
applications that support TWAIN-compliant scanning.
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■ MultiPASS Service (Windows NT only)
The MultiPASS Service (MPService) enables and controls all the communication between
your computer and the MultiPASS. MPService must be running for jobs to be processed
with the Desktop Manager and the MultiPASS (such as receiving faxes in the Desktop
Manager, scheduling faxes, scanning, and printing).

MPService starts automatically when you start your computer, even if you have not yet
logged into Windows. If you log off Windows and leave the computer on, MPService
continues to run, to receive and send any faxes to and from the Desktop Manager.

■ MultiPASS Status Monitor
The MultiPASS Status Monitor controls and tracks the activity occurring through the bi-
directional parallel port to which the MultiPASS is connected. The Status Monitor must be
running to enable the MultiPASS system to function successfully. The Status Monitor
displays status messages about the current activity with your MultiPASS system. With the
installation of the software, the Status Monitor is set up to automatically start when you
start Windows.

■ Send Fax Manager
The Send Fax Manager displays an ordered queue of fax jobs and their status.

■ MultiPASS Toolbar
The MultiPASS Toolbar enables you to scan an image from the Windows desktop without
opening an imaging application (such as Photoshop®) or the Desktop Manager. The
scanned image is delivered directly to a destination, such as a fax or to the desired
application (such as your e-mail application or a graphic application).
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Using Your Documentation
Your MultiPASS includes the following documentation to help you learn how to use your unit
quickly and easily:

■ Quick Start Guide
This foldout sheet describes how to unpack and set up your new MultiPASS unit. It
includes instructions on how to install the software that comes with the MultiPASS,
including the MultiPASS Desktop Manager for Windows, ScanGear for MultiPASS, and
the MultiPASS Printer Driver. This software enables you to use all the features of the
MultiPASS — color printing, color copying, color faxing, PC faxing, and color scanning.

■ MultiPASS C530/C560 User’s Manual
This online manual offers detailed information on how to operate your new MultiPASS. It
describes how to use the MultiPASS as a monochrome or color printer and covers the
basics on how to send and receive faxes. It also includes maintenance, troubleshooting, and
specifications.

■ MultiPASS Desktop Manager Software Guide
This online manual describes how you use the MultiPASS Desktop Manager, which is a
software application that provides all the PC faxing and scanning capabilities of your
MultiPASS. If you plan to use the PC faxing and scanning features of the MultiPASS, you
must install the MultiPASS Desktop Manager software. You can then use the Desktop
Manager to define and control all of the features of the MultiPASS.
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■ Stand-alone Fax Manual
This online manual describes how you use the operation panel on the MultiPASS to control
all your faxing and receiving functions. If you decide not to install the MultiPASS Desktop
Manager, you can still use many of the features of the MultiPASS. In this case, you will
define and control the features of the MultiPASS through the operation panel.

About This Guide

This guide assumes you have a basic understanding of Windows. This includes how to start
your system and navigate within the Windows environment. You should be familiar with
common Windows terms such as window, dialog box, button, icon, menu, application, select,
open, close, click, double-click, drag, and list box.

For assistance in familiarizing yourself with Windows, refer to your Microsoft® Windows user
documentation.

Conventions Used in This Guide

The following types of formatting identify specific types of information provided in this guide.
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Italicized text Used to stress the importance of a word or phrase, or to refer to
the title of another guide. For example:

You cannot access the dialog box ....
—or—
...the Microsoft Windows User’s Guide....

Text in quotation marks Used to refer to the title of a section within the guide. For
example:

...the “Installing the Software” section....

Click, double-click Use of the word click or double-click provides instructions for
selecting or choosing a command or option, generally with a
mouse.

Monospaced text Used for commands you might type when installing the
software, or system messages that may display on your screen.
For example: A:\SETUP

Other User Assistance

In addition to this guide, the MultiPASS Desktop Manager includes online help. The online help
includes context-sensitive help about a window or dialog box and step-by-step instructions for
performing Desktop Manager tasks.
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Using the MultiPASS Toolbar
The MultiPASS Toolbar displays as an icon on the Windows desktop. When you click the icon
(or press Start/Scan on the MultiPASS), the MultiPASS Toolbar (hereafter referred to as the
Toolbar) displays on the Windows desktop and enables you to scan a document or image,
without opening a graphics application or the Desktop Manager.

When you scan a document, the system uses defined settings that determine the characteristics
of your scanned image (such as the image type and resolution). The settings are predefined,
enabling you to begin scanning with the Toolbar immediately. However, you can change these
settings as needed.

The following illustration includes each of the buttons that may display on the Toolbar. The
button icons may vary somewhat based on your Toolbar settings. You can also adjust the
Toolbar settings to display only those buttons that are convenient for you.

Fax

Mail

Scan Text

Scan Photo

Custom

Desktop Manager

Toolbar Settings

Help
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The Fax, Mail, Scan Text, Scan Photo, and Custom buttons enable you to scan a document
or image to a particular destination. For example, you may want to scan a document, and
immediately send it as a fax or attach it to an e-mail message.

When the Toolbar is running, a minimized icon appears on the Windows taskbar.

To scan with the Toolbar:
1. Place your document or image facedown in the Automatic Document Feeder (ADF) of

your MultiPASS.

2. On the Windows desktop, on the MultiPASS Toolbar:

� Click Fax to scan your document and automatically send it as a fax in the Desktop
Manager.

� Click Mail to scan your document and automatically attach it to a message in your
e-mail application.

� Click Scan Text to scan your document and automatically have it display in a text
editor application (such as TextBridge™).

Toolbar Icon
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� Click Scan Photo to scan your document and automatically have it display in a graphic
application (such as Adobe PhotoDeluxe®).

� Click Custom to scan your document and automatically have it display in an
application you assigned in the Toolbar settings (such as Microsoft Paint™).

3. If the ScanGear window appears, set your scan options as desired and scan your document.
These settings override any scan settings defined in the Toolbar. For details on defining
scan options in the ScanGear window, see Chapter 4, Scanning.

If the ScanGear window does not appear, skip to Step 4.

4. When the MultiPASS begins to scan the document, the MultiPASS Toolbar dialog box
displays the progress of the scan activity.

Based on your Toolbar settings, a preview of the scanned image may appear in the Toolbar
dialog box. When the scan is complete, click OK to accept the image and continue to the
destination for your scanned image. If you are dissatisfied with the image, click Cancel.

If a preview image does not appear, the image is immediately sent to its destination.
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5. When the scan is complete and, if necessary, the image is accepted, do one of the following:

� If you clicked Fax in Step 2:
In the Send Fax dialog box, enter the appropriate information and send the fax. For
details, see Chapter 3, PC Faxing.

� If you clicked Mail in Step 2:
In the e-mail message window, enter the appropriate information and send the e-mail
message.

� If you clicked Scan Text in Step 2:
The image automatically appears in the associated text editor application.

� If you clicked Scan Photo in Step 2:
The image automatically appears in the associated graphic application.

� If you clicked Custom in Step 2:
The image automatically appears in the software application set up as the custom
application in your Toolbar settings.

n
For complete details on scanning, see Chapter 4, Scanning.
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Changing the Options for the Scan Buttons on the Toolbar

In the Toolbar settings, you can define certain features associated with the scan buttons on the
Toolbar. These features include scan settings that the Toolbar uses automatically to produce the
scanned image. These settings are defined independently for each scan destination available, such
as scan to fax or scan to mail. Although these settings are predefined so you can begin scanning
with the Toolbar immediately after installing the MultiPASS software, you can change these
settings as needed.

To change the scan button options:
1. On the Windows Desktop, right-click on the MultiPASS Toolbar icon, and then click Toolbar

Settings.



Chapter 1 Introduction    1-15

2. In the Toolbar Settings dialog box, select the appropriate tab for the scan button whose
settings you want to change: Fax, Mail, Scan Text, Scan Photo, and Custom.

3. On the appropriate tab, make your preferred changes.

4. Click OK to save the changes.

Click Cancel to close the Toolbar Settings dialog box without saving the changes.
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Defining the Scan Button Options

On the applicable tab in the Toolbar Settings dialog box, you can change the following options:

■ Show This Button on Toolbar
Select this option to display the button associated with this scan destination on the Toolbar.
If this option is cleared, the button does not appear on the Toolbar.

■ Link To
On the Fax tab, this option displays the MultiPASS fax driver that is used to send your
scanned document as a fax.

On the Scan Text, Scan Photo, and Custom tabs, this option displays the path and executable
file for the application associated with the scan destination. The Scan Text and Scan Photo
buttons may be factory-defined with an application bundled with your MultiPASS software.
For example, the Scan Text button may be linked to the TextBridge application. The Custom
tab enables you to associate your preferred application with the Custom button.

■ Set
On the Fax tab, click to change the fax options used when faxing the scanned document with
the Fax button. In the Fax Properties dialog box, specify your changes (such as paper size)
and click OK.

On the Scan Text, Scan Photo and Custom tabs, click to select the application you want
associated with this scan destination. For details, see “Linking an Application for a Toolbar
Scan Button” later in this section.
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■ Save as Type
If available on the tab, click the file format in which you want your scanned image saved,
such as BMP or TIF. This option is available only for those scan destinations where saving
the image file is appropriate.

■ Image Type
Select the type of image you are scanning, such as Black and White.

■ Image Quality (Resolution)
Select the resolution (in dots per inch, dpi) for the image you are scanning. A higher
resolution results in a better image quality, but may take longer to scan. A lower resolution
generally scans faster, but may generate a lesser quality image.

■ Paper Size
Select the physical size of the image being scanned, such as letter or business card size. You
can also define a custom paper size. For details, see “Defining a Custom Paper Size” later in
this section.

■ Weight and Size
Based on the paper size you selected, the corresponding width and height display. If you
selected the custom paper size, you can define the width and height. You can also select the
unit of measure by which you want to display or define the width and height.
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Linking an Application for a Toolbar Scan Button

When linking an application to a button, you need to know the program or executable (.EXE)
file associated with the application and where this file is located on your system. For example, to
link Microsoft Paint to the Custom button, you would need to know the path and the
executable file name for Paint (PBRUSH.EXE).

To link an application:
1. On the Scan Text, Scan Photo, or Custom tab, click Set.

2. In the Select Application dialog box, select the path and file name for the application
executable file. Then click Open.

Your selection displays in the Link To box.
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Defining a Custom Paper Size

1. On the applicable tab, in the Paper Size box, click Custom.

2. Select the unit of measure by which you want to define your custom paper size.

3. In the Width and Height boxes, enter the dimensions of your custom paper size.

Changing Toolbar Settings

You can change certain characteristics about the Toolbar, such as its appearance and
performance.

To change Toolbar settings:
1. On the Windows Desktop, right-click on the MultiPASS Toolbar icon, and then click

Toolbar Settings.

2. In the Toolbar Settings dialog box, select the Toolbar Settings tab.
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3. Specify your changes.

4. Click OK to save the changes.

Click Cancel to close the Toolbar Settings dialog box without saving the changes.
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Defining the Toolbar Settings

You can define the following options on the Toolbar Settings tab.

■ When Scan Push Button Pressed
You define the desired action that occurs when you push the scan button on your
MultiPASS. In the When Scan Push Button Pressed box, select the desired action. For
example, you can set the button to display the Toolbar, or to send the scanned document to
a particular destination, such as fax.

■ Show ScanGear Before Scanning
Click to display the ScanGear window when you scan a document in the Toolbar. When the
ScanGear window is displayed, you can set and adjust scan options, and then rescan the
document, before accepting the final scanned image. The options you set override the scan
options set in the Toolbar.

If this option is cleared, the image is scanned based on the scan settings defined in the
Toolbar.

■ Preview
Click to display a preview image during the scanning of a document in the Toolbar
progress dialog box. This option enables you to preview the image before accepting or
canceling the image.

If this option is cleared, the image is immediately sent to its destination.
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■ Toolbar Always on Top
Click to keep the Toolbar displayed on top of all applications that may appear on the
Windows desktop.

■ Load on Windows Startup
Click to open the Toolbar when Windows is started. In this case, the Toolbar is minimized
initially, with an icon appearing on the Windows taskbar.

If this option is cleared, you need to open the Toolbar when you want to use it.

■ Button Style
Select your preferred display size for the Toolbar buttons.

Performing Other Toolbar Tasks

This section describes other tasks you can perform with the Toolbar, such as opening the
Desktop Manager.

Opening the Desktop Manager

You can open the Desktop Manager on the Toolbar, opening either the Desktop Manager main
window or a specific area of the Desktop Manager.
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To open the Desktop Manager:
Do one of the following:

■ On the Toolbar, click Desktop Manager.

■ On the Toolbar, click Toolbar Settings.
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In the Toolbar Settings dialog box, select the Desktop Manager tab, and then select one of the
following:

� Fax Setup
Click to set the preferences, send fax, receive fax, and speed dial options.

� Address Book
Click to set up the address information for each of your business and personal contacts.

� System Setup
Click to set up system options for the Desktop Manager.

� Fax Log
Click to review the history of your fax activity.

Hiding and Displaying the Toolbar

If the Toolbar displays on the Windows desktop, you can hide it but still retain the Toolbar icon
on the Windows taskbar. If the Toolbar appears only as a minimized icon, you can display Toolbar
on the Windows desktop.

To hide the toolbar:
On the Toolbar, click the Close button on the title bar.
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To show the toolbar:
On the Windows taskbar, do one of the following:

■ Select the Toolbar icon. On the displayed menu, click Show Toolbar.

■ Double-click the toolbar icon.

Opening and Closing the Toolbar

Based on your Toolbar settings, the Toolbar may not automatically open in Windows (where it
can appear on either the Windows desktop or taskbar). To use the Toolbar, you need to open it
when necessary.

To open the Toolbar:
On the Windows desktop, click Start. Point to Programs. Then point to MultiPASS Suite. Then
click MultiPASS Toolbar.

To close the Toolbar:
1. On the Windows taskbar, right-click the Toolbar icon.

2. On the displayed menu, click Exit MultiPASS Toolbar.

n
The Status Monitor must be running prior to opening the Toolbar. For more information, see
the “Using the MultiPASS Status Monitor” section in Chapter 6, Utilities.
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Displaying Information About the Toolbar

You can display version and copyright information about the Toolbar.

1. On the Windows taskbar, right-click the Toolbar icon.

2. On the displayed menu, click About.

n
As an alternative for performing some of the tasks described for the Toolbar (such as scanning
to a particular destination), you can use the Toolbar menus. To do so: On the Windows taskbar,
click or right-click the Toolbar icon. On the displayed menu, select the desired command.
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Chapter 2
Using the Desktop Manager

This chapter provides an overview of the basic features of the Desktop Manager.

For detailed information and instructions on Desktop Manager tasks, refer to later chapters in
this guide.

❑ Desktop Manager: An Overview ......................................................................................... 2-2
� Features of the Desktop Manager Window .................................................................. 2-4
� Understanding Desktop Manager Folders .................................................................... 2-8
� System-Defined Folders ................................................................................................. 2-9
� User-Defined Folders ................................................................................................... 2-11
� Viewing Documents in the Desktop Manager ........................................................... 2-11
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Desktop Manager: An Overview
The MultiPASS Desktop Manager is a full-featured Windows application that enables you to use
your MultiPASS from your computer. With the Desktop Manager, you can:

■ Send and receive faxes from and to your computer

■ Scan images into your computer

■ Store faxes and scanned images in folders on your computer

■ Import or export a document

■ Manipulate stored documents by removing a page; splitting or merging it with another
document; editing it by cropping, rotating or flipping; adjusting the document brightness,
contrast, size, or image type; or by printing the document

■ Annotate a stored document

■ Set up an address book for individuals or groups to whom you repeatedly send faxes or
e-mail
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■ Design your own fax cover page

■ Define system options for the MultiPASS

■ Complete other tasks such as phoning an individual with an extension telephone connected
to your MultiPASS and monitoring the status of your Desktop Manager jobs.

To start the MultiPASS Desktop Manager:
1. On the Windows desktop, click Start, and then point to Programs.

2. In the Programs menu, point to Canon MultiPASS Suite, and then click MultiPASS
Desktop Manager.

To close the Desktop Manager:
On the File menu, click Exit.

When you exit the Desktop Manager, you close only the Desktop Manager window. Any
documents you have set up to PC fax or print remain active. The MultiPASS Status Monitor and
the Send Fax Manager, which track the progress of your active jobs, also remain open and
active.
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Features of the Desktop Manager Window

This section provides an overview on the basic use of the MultiPASS Desktop Manager window.
Detailed instructions for using its commands and components are provided in later sections of
this chapter.

Menu Bar

Document Toolbar

Action Toolbar

Command Bar

Work Area

Folders List

Status Bar
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■ Menu Bar
The menu bar contains the commands that enable you to perform the various Desktop
Manager tasks. Many of the commands can also be accessed using their corresponding
button on the toolbar.

Some of the menu commands are also available on shortcut menus, which are displayed by
clicking the right mouse button in the Desktop Manager window.

■ Document Toolbar
The Document toolbar provides quick access for performing manipulation tasks with a
selected document. In circumstances where a task is not possible, the toolbar button is
unavailable, appearing dimmed.

           

■ Action Toolbar
The Action toolbar provides quick access for performing certain Desktop Manager tasks. In
circumstances where a task is not possible, the toolbar button is unavailable, appearing
dimmed.

Document
     View

List View      Edit
Keywords

Search
Manual
Indexing

Show Search
    Results

Select All Arrange

Duplicate Remove
   Page

Split

Merge



Chapter 2 Using the Desktop Manager    2-6

          

You can move the action or document toolbar anywhere on the Desktop Manager
workspace to better suit your own working habits.

ToolTips are also available, providing descriptions of the toolbar buttons. To display a
ToolTip, pause the mouse pointer when it is directly over a button.

■ Folders List
The folders list contains folders that store your documents. The list contains both system-
defined folders, which were automatically created when you installed the software, and
user-defined folders, which you create as you need them.

■ Work Area
The work area appears to the right of the folders list and displays the documents contained
in the open folder. The documents are displayed either as a graphic thumbnail of each
document, or a list of the documents.

The width of the work area can be adjusted by dragging the border (the split bar) between
the work area and folders list.

Scan

Fax Memo

Import

Address
  Book

Fax Log

Cover Page
 Designer

Manage Cover
      Pages

Send Fax
Manager

   Help
Contents

Delete

Fax Setup
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■ Command Bar
The Command bar is located at the bottom of the work area and contains buttons that
perform key processing tasks. You can also launch other Windows applications such as your
e-mail program, Paint, or WordPad.

         

A Phone button displays if an extension telephone is connected to your MultiPASS and you
set the telephone option in the Desktop Manager Setup Options dialog box. This is
described in detail in Chapter 6, Utilities.

You use command bar buttons as follows.

� Drag a document to the button. For example, you can drag a document from a folder
to the Print button in order to print the document.

If you drag a document to a button that cannot perform the task, the mouse pointer
displays as a No icon (a circle with a diagonal bar drawn through it).

Launcher  Application

Print Send Fax    Phone

   Open
Document Send E-mail   Export
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� Select a document in a folder, and then select a button. This method activates the
command for the selected document, as though the document had been dragged to the
button.

� Select a launching icon. This starts the application as if it were started from the
Windows desktop.

■ Status Bar
The status bar displays information about the selected document or folder, or a description
of the currently selected menu or toolbar command. It also displays the current date and
time. The information is for display only, and cannot be edited.

Understanding Desktop Manager Folders

The Desktop Manager stores and organizes documents in folders. Only one folder can be open
at a time. When you open another folder, the current folder closes.

You can organize your documents in any manner you want, placing documents in folders, or
folders within folders as may be desirable.
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System-Defined Folders

When you installed the Desktop Manager, a number of system-defined folders were
automatically created — In Box, Sent Fax, Scan, Trash, and Cabinet (which contains the folders
you create). You can tell which folder is open by the folder icon.

You cannot add new folders or documents to the system-defined folders. They are reserved for
use by the Desktop Manager in the following ways:

■ With the exception of the Trash folder, only the Desktop Manager can place documents in
system-defined folders, based on faxes sent or received, or images scanned. You can rename,
copy, move, delete, or manipulate documents in these folders.

■ The system-defined folders, including the Trash folder, cannot be deleted or renamed.

A document remains in a system-defined folder until you move it to a user-defined folder, or
delete it.

In Box Folder

The In Box folder is automatically opened each time you start the Desktop Manager (even if it
is empty). It stores all incoming faxes that were sent to you by other fax machines, received by
your MultiPASS, and then uploaded to your PC.

Each received fax is displayed using a system-assigned name. You can change the name to
something more descriptive.
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Sent Fax Folder

The Sent Fax folder contains all documents which have been successfully sent as PC faxes and
which you requested not to be deleted after sending. Each sent fax displays with a system-
assigned name, which you can change as desired.

Scan Folder

The Scan folder stores all images you scan with the MultiPASS from the Desktop Manager. Each
document displays with a system-assigned name, which you can change as desired.

Trash Folder

The Trash folder stores all the documents you remove from the other folders. Once a document
is moved to the Trash folder, it remains there until you delete it.

You can fax, print, or open documents in the Trash folder.
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User-Defined Folders

You can create an unlimited number of folders for your own use in the Cabinet. You cannot
place documents directly into the Cabinet; you must place them in folders within the Cabinet.

Viewing Documents in the Desktop Manager

When you open a folder, you can view the documents contained in that folder in Document
View or List View.

If the number of documents within a folder exceeds the available work area, horizontal and/or
vertical scroll bars display. You can use them to scroll through the work area to view all the
documents.

To open a folder:
In the folders list, select the desired folder.
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Document View

Document View displays each individual document as a thumbnail titled with the document
name. For multiple page documents, the thumbnail also displays the page count, as well as scroll
arrows at the bottom, and a scroll box at the right side. The scroll arrows and scroll box enable
you to page through a multi-page document, displaying each page in turn or moving to a
particular page in the document.
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Document View allows you to work with an individual document at the page level: scrolling
pages, removing a page, splitting a document, or merging two or more documents into a single
document. You can rearrange the document thumbnails within the work area as needed by
simply dragging them to the desired location.

To view documents in a folder as thumbnails:
With the folder open, click Document View on the View menu or toolbar.

List View

List View displays documents within the open folder as a list. Each document in the list displays
an icon representing the document type, along with other pertinent information about the
document (such as its name, page count, disk storage size, date and time of creation, and its
origin).
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The icon designates the document type as fax, scan, or modified. A modified document is a
document where the fax cover page has been removed, a scanned document that has been
annotated, or a multi-page document that has been split into multiple documents.

Documents displayed in List View cannot be manipulated as in Document View, such as by
splitting a document or merging two or more documents.

To view documents in a folder as a list:
With the folder open, click List View on the View menu or toolbar.
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Sorting Documents in the List

You can change the order of listed documents in both system-defined and user-defined folders
using any of the column label criteria displayed at the top of the list. Sorting by page, size, or
date and time displays the largest or most current document last. The list displays in the selected
order until you change the sort option.

To change the order of the list:
Select the title of the appropriate column at the top of the list.
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n With the installation of the MultiPASS Desktop Manager, the MultiPASS Toolbar icon displays
on the Windows desktop. Simply click the icon to open the MultiPASS Toolbar. For information
and instructions, see the “Using the MultiPASS Toolbar” section in Chapter 1, Introduction.
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Chapter 3
PC Faxing

This chapter provides information and instructions for sending and receiving a fax, setting up
the Address Book, and designing your own fax cover page.

❑ Faxing With Your Computer ............................................................................................... 3-3
� Sending a Fax From Your Computer (PC Faxing) ...................................................... 3-4
� Specifying a Fax Recipient ............................................................................................ 3-8
� Defining Send Fax Options ........................................................................................ 3-12
� Processing the Fax ....................................................................................................... 3-15
� Creating a Fax Memo .................................................................................................. 3-18
� Receiving a Fax ............................................................................................................ 3-20
� Using the Fax Log ........................................................................................................ 3-22
� Working With Jobs in the Send Fax Manager ............................................................ 3-25

❑ Setting Up the Address Book............................................................................................. 3-32
� Working With Address Book Entries ......................................................................... 3-33
� Printing the Address Book .......................................................................................... 3-40
� Importing the Address Book ...................................................................................... 3-40
� Exporting the Address Book ....................................................................................... 3-44
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❑ Designing a Fax Cover Page .............................................................................................. 3-46
� Using the Cover Page Designer .................................................................................. 3-47
� Creating a New Cover Page ......................................................................................... 3-50
� Making Image Adjustments ........................................................................................ 3-71
� Adding Annotations to Your Cover Page ................................................................... 3-88
� Opening and Modifying a Fax Cover Page ................................................................ 3-91
� Reverting to the Last Saved Version ........................................................................... 3-93
� Printing a Cover Page .................................................................................................. 3-93
� Renaming a Cover Page .............................................................................................. 3-94
� Deleting a Cover Page ................................................................................................. 3-95

❑ Faxing With Your E-Mail Application .............................................................................. 3-96
� Setting Up MultiPASS Fax in Your E-mail Application ............................................. 3-97
� Sending an E-mail Message as a Fax .......................................................................... 3-98
� Receiving a Fax ............................................................................................................ 3-99
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Faxing with Your Computer
You can use the Desktop Manager, with your MultiPASS, to send and receive faxes. You can also
set up an Address Book, containing fax and e-mail information for people to whom you often
send faxes, and design your own fax cover pages. To assist you in managing your faxes, a Fax Log
maintains a record of every fax you send or receive.

You can also customize your MultiPASS by changing the factory default user settings. The
settings include the date format that displays on your faxed documents, or how many times the
MultiPASS calls another fax unit if the other party’s line is initially busy. You can also register
one-touch/coded speed dial and group numbers using the Desktop Manager and then
download them to the MultiPASS. For details on changing setup options, refer to Chapter 6,
Utilities.
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Sending a Fax From Your Computer (PC Faxing)

You can send a PC fax from any Windows application that supports document printing using
the MultiPASS fax driver.

The MultiPASS Desktop Manager sends the PC fax to the Send Fax Manager, where its progress
is tracked until it is actually transmitted. If you specified multiple recipients, an individual fax
job for each recipient is sent to the Send Fax Manager. Once transmitted, the fax is placed in
your Sent Fax folder (unless you specified that it be deleted after transmission). A record of the
sent fax is also recorded in the Fax Log. If a fax fails (for example, because of an incorrect fax
number), it remains in the Send Fax Manager until you attempt to resend it or delete it.

When you send a PC fax, you provide fax information about each recipient, such as the
recipient’s name and fax number. If, as part of the recipient’s information, you provide the
recipient’s e-mail address, the document can be transmitted as an e-mail message. The e-mail
feature is possible if you have an e-mail application installed on your system that is Messaging
Application Program Interface (MAPI)-compliant (such as Microsoft Exchange). Your e-mail
application must be set up as the system default MAPI client. For details, see your e-mail
application documentation.

n
Before sending a PC fax, make sure that the date and time in your computer is correct. The
system date and time displays on all PC faxes that you send. If you need to change the date and
time, refer to your Windows user documentation.
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The following instructions summarize the overall procedures for sending a PC fax.

To send a PC fax:
1. With the document you want to fax open in a Windows application (such as Word), click

the Print command. (In most Windows applications, the command is on the File menu or
toolbar.)

2. In the Print dialog box, select Canon MultiPASS Fax as your printer in the Printer list, and
then click OK.
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3. In the Send Fax dialog box, enter the recipient for your fax.

� For a onetime recipient, enter the name and fax number or e-mail address in the First
Name, Last Name, Fax, and E-mail Address boxes.

� For an entry listed in your address book, click the applicable name in the To list box,
and then click Add.
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4. For a onetime recipient, select Use Outside Dialing Prefix if you need to use a prefix (for
example, 9) to access an outside line in dialing the fax number.

5. Optionally, select and enter any of the following send fax options:

� Enter the name of your recipient’s company in the Company box.

� Enter the fax subject in the Subject box.

� To attach a cover page to your fax, select it in the Template list. If you do not want to
use a fax cover page, select None.

� Enter your name and telephone number (the Sender) in the From and Phone boxes.

� Enter any desired comments or notes, which display on the cover page, in the Memo
box.

� To delete the fax after it is sent, click Delete After Sending.

� To include any annotations that were added to the fax using the MultiPASS Viewer,
click Include Annotations.
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6. After completing your fax entries, process the fax as follows:

� To send the fax or e-mail immediately, click Send Now.

� To send the fax at a specified later time, click Send Later. This option is not available
for sending e-mail.

� To hold the fax indefinitely, preserving all fax options, click Hold. This option is not
available for sending e-mail.

� To close the dialog box without sending the fax, canceling the specified fax options,
click Cancel.

Specifying a Fax Recipient

To send a fax, you must insert the required recipient information in the Send Fax dialog box.
The required information is your recipient’s first and last name and your recipient’s fax number
or e-mail address.

You can insert the required information into the Send Fax dialog box by using one of three
methods: you can specify a onetime fax recipient, select entries from your Address Book, or a
combination of both.
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Specifying a Onetime Recipient

You specify a onetime recipient by entering the name and fax number or e-mail address in the
First Name, Last Name, Fax, and Email Address boxes.

Entering a Fax Number
In the Fax box, when you enter a fax number, use the actual numbers plus any valid characters
that separate the different segments of the fax number. For example, you can use 0 through 9,
dash (–), or parentheses (). For a complete list of the characters that are valid in the Desktop
Manager, refer to Appendix A.

Entering an E-mail Address
If you enter an e-mail address instead of a fax number, you cannot hold the e-mail or schedule
it for sending later.

Including a Fax Recipient from the Address Book

The To list box displays all recipients which have been set up in the Address Book. You can
include one or more recipients by selecting the name and clicking Add. Selected names display
in the Recipients list box and appear disabled in the To list box. This is to prevent the same
recipient from being selected twice.
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Removing a Fax Recipient
You can remove a name included in the Recipients list box by clicking the name, and then
clicking Remove. If the recipient was previously added to the Address Book, the name again
becomes available in the To list box.

Adding a New Recipient to the Address Book
If you want to add a new fax recipient to your Address Book, you can do so as follows:

1. Enter the recipient information in the First Name, Last Name, Company, Prefix, Fax, and
Email Address boxes.

2. Click New Individual Entry.

3. Complete the fields in the New Recipient dialog box as necessary and click Add.

n
You can also click the New Individual Entry button without first entering the recipient
information in the Send Fax dialog box. In this case, a blank New Recipient dialog box displays.
Complete the appropriate information and click Add.

For detailed instructions on using the New Recipient dialog box to add a new individual to the
Address Book, refer to the “Working with Address Book Entries” section in this chapter.
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Specifying a Dialing Prefix

In some office environments, you may need to enter a prefix for the fax number, which is the
number required to connect you to an outside phone line (usually 9).

For a onetime recipient, you must select the Use Outside Dialing Prefix option in the Send Fax
dialog box if you need to use a prefix (such as 9) to access an outside line.

For a recipient from the Address Book, if you selected the Use Outside Dialing Prefix option in
the New Entry or New Recipient dialog box used to create their entry, you do not need to select
Use Outside Dialing Prefix.
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Defining Send Fax Options

The following sections provide additional information on defining options in the Send Fax
dialog box.
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Attaching a Cover Page

As desired, you can attach a cover page to your fax. The Desktop Manager contains a library of
predefined fax cover pages, each providing a different style for both business and personal use.
In addition, you can design your own cover page using the MultiPASS Cover Page Designer and
add it to the library.

For instructions on designing your own cover page, refer to the “Designing a Fax Cover Page”
section in this chapter.

Previewing the Cover Page

To view a selected cover page before sending the fax, click Preview. The cover page displays the
specified recipients and other fax information, including memo text. This display is read only,
and cannot be edited.

To print the cover sheet, click Print on the File menu or toolbar. In the Print dialog box, select
your printing options and click OK.

To close the Preview window, click Exit on the File menu. For instructions on editing a cover
page, refer to the “Designing a Fax Cover Page” section in this chapter.
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Entering Fax Sender Information

To identify yourself as the sender of the PC fax, enter your name and telephone number in the
From and Phone boxes. Once you send your first PC fax, this information is automatically
displayed the next time you send a PC fax. You can then change the fax sender information as
desired.

Entering a Memo

You can include a memo on the fax cover page if the cover page has been designed to accept
memo text. The font, style, and size of the memo text are determined by the particular design of
the selected cover page. You can change these attributes using the MultiPASS Cover Page
Designer. For instructions on editing a cover page, refer to the “Designing a Fax Cover Page”
section in this chapter.

Deleting the Fax After Sending

If the Delete After Sending option is selected, the fax is automatically deleted after it has been
successfully transmitted. This option makes it easy to keep your computer free of unneeded
documents, thereby maximizing your available disk space.

If this option is not selected, the fax is automatically moved from the Send Fax Manager to the
Sent Fax folder after transmission.
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Including Annotations

Using the editing capabilities of the MultiPASS Viewer (described in Chapter 5, Working With
Documents), you may have modified your document — for example, by adding text
annotations, graphic or text stamps, or highlighting. In this case, you can select to include these
modifications by clicking the Include Annotation option.

If this option is not selected, the original version of the document is faxed, without any added
annotations.

Processing the Fax

You can send your fax — either now or later — only when at least one recipient and fax number
has been specified. As necessary, you can also place a fax on hold and return to it later. The
following sections provide additional information on these processing options.

Sending the Fax Now

When you click Send Now, the fax document is sent to the Send Fax Manager until it is
transmitted. Once transmission is complete, the fax is either moved to the Sent Fax folder or
deleted, based on whether you enabled or disabled the Delete After Sending option.
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If you entered both an e-mail address and a fax number, when you click Send Now, the Select
Send Preference dialog box appears.

In the Select Send Preference dialog box, specify your desired sending mode, and then click OK.

Sending the Fax Later

If you prefer to send the fax later, you can specify the date and time to send it by clicking Send
Later. In the Send Later dialog box, select the desired transmission date and time from their
respective lists, and click OK.

n
The Send Later option only applies to faxes; it does not apply to e-mail messages. If you
specified both a fax number and an e-mail address in the Send Fax dialog box, when you click
Send Later, the fax is scheduled for the designated fax recipients, and the e-mail message is sent
to the designated e-mail recipients.
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The fax is sent to the Send Fax Manager for processing at the specified date and time.

Holding the Fax

You can place a fax document on hold at any time prior to sending it. The held fax is sent to the
Send Fax Manager with no specified transmission time. Any fax information you entered —
such as recipients or cover page information — is preserved. You can decide later whether to
send the fax — revising the send information as needed — or to delete it.

If you specified both a fax number and an e-mail address in the Send Fax dialog box, in the
Select Send Preference dialog box that appears, click Email or Fax. Then click OK.
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n
The Hold option only applies to faxes; it does not apply to e-mail. If you specified both a fax
number and an e-mail address in the Send Fax dialog box, when you click Hold, the fax is held
for the designated fax recipients, and the e-mail message is sent to the designated e-mail
recipients.

Canceling the Fax
If you cancel the fax while working in the Send Fax dialog box, you are returned to the
application where you originally initiated the Send Fax (or Print using the MultiPASS Fax
driver) command.

Creating a Fax Memo

A fax memo is generally a brief, one-page fax sent directly from the Desktop Manager, without
using another Windows application to create it. Operating directly from the Desktop Manager,
you specify the same fax options as described in the previous sections of this chapter.

To create a fax memo:
1. In the Desktop Manager, click Fax Memo on the File menu or toolbar.

2. In the Send Fax dialog box, specify your fax options, as described in the previous section:

� Select a cover page from the Template list, then enter the message of your fax in the
Memo box.
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� Revise the Sender name and phone number as necessary.

� Click Delete After Sending to delete the fax after it is successfully transmitted.

3. After completing the entries in the Send Fax dialog box, process the fax:

� To send the fax immediately, click Send Now.

� To send the fax at a later time and date, click Send Later.

� To hold the fax indefinitely, click Hold.

� To close the dialog box without sending the fax or an e-mail, click Cancel.

Because the fax memo is not originating from a document created in another Windows
application, be sure to enter the memo message in the Memo box. Also, since your fax memo
does not originate from a document that may have been annotated in the MultiPASS Viewer,
the Include Annotation option will not be available for selection.
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Receiving a Fax

All incoming faxes are received by your MultiPASS and can be uploaded to the Desktop
Manager for viewing, printing, or replying. Uploaded faxes are stored in your In Box folder. A
flashing icon in the taskbar indicates that you have received a new incoming fax. Once you open
the folder to review the newly received fax, the flashing icon no longer displays until another fax
is received.

A received fax displays in the In Box folder with a system-assigned name. The fax remains in the
In Box folder until you move or delete it.

You can receive faxes regardless of whether your computer is turned on or off.

If Your Computer Is Turned On

If your computer is turned on when the MultiPASS receives a fax, the Desktop Manager handles
the fax using one of the following methods, based on how you defined your setup options:

■ Print the fax directly from the MultiPASS
You can set the MultiPASS to automatically print incoming faxes and not upload them to
the Desktop Manager.
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■ Upload the fax to the Desktop Manager
You can set the MultiPASS so that received faxes are automatically moved to the Desktop
Manager. By uploading a fax, you store a copy of it in your In Box allowing you to review,
annotate, print, or resend the fax to another recipient.

If Your Computer Is Off

If your computer is turned off when the MultiPASS receives a fax, the MultiPASS handles the fax
using one of the following methods, based on how you defined your setup options:

■ Print the fax directly from the MultiPASS
If your computer is going to be off for a while, or you are expecting many incoming faxes, it
is recommended that you set the MultiPASS to automatically print incoming faxes. This
recommended setting enables you to leave the computer off for a period of time and still be
assured of receiving your faxes. You can always later scan a printed fax into the Desktop
Manager.

■ Save the fax in MultiPASS memory
If you set the MultiPASS to save a fax in memory, it can later be printed directly to the
MultiPASS, or sent to the Desktop Manager when your computer is turned on.
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When a fax is saved in MultiPASS memory, a notification message appears on the MultiPASS
LCD display.

To move received faxes to the Desktop Manager:
1. Turn on your computer and start Windows.

2. Launch the MultiPASS Status Monitor.

Faxes are automatically moved to the In Box folder in the Desktop Manager.

Using the Fax Log

The Fax Log contains a list of fax activity (faxes sent and received). Each fax lists historical
information, such as transmission status, date and time the fax was sent or received, the
recipient of the fax, and the number of pages. You can use the Fax Log for a variety of purposes,
such as reviewing the error status of a failed PC fax.

When reviewing the Fax Log, you can also print it.
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To display the Fax Log:
1. In the Desktop Manager, click Fax Log on the Tools menu or toolbar.

2. To display details and log notes about a particular fax document, select the fax.
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To print the Fax Log:
1. In the Fax Log dialog box, click Print.

2. In the Print dialog box, specify the desired print options and click OK.

This report provides you with a hard copy of the Fax Log information.
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To delete an entry in the Fax Log:
1. Select the entry you want to delete.

2. Click Delete.

To close the Fax Log:
Click OK.

Working With Jobs in the Send Fax Manager

For each PC fax you send, a job is created in the Send Fax Manager. The Send Fax Manager
displays the current status of each job.

While working in the Send Fax Manager, you can:

■ Stop an active job from PC faxing

■ Send a PC fax that has been scheduled for sending later, held, or has failed

■ View a PC fax that has been scheduled for sending later, held, or has failed

■ Delete a job that is not active.
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To display the Send Fax Manager:
1. In the Desktop Manager, click Send Fax Manager on the Tools menu or toolbar.

2. On the Windows desktop, click Start, and then point to Programs.

3. On the Programs menu, point to MultiPASS Suite. Then click Send Fax Manager.

Features of the Send Fax Manager Window

The Send Fax Manager window contains the following features:
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■ Menu Bar
The menu bar contains the commands that enable you to perform the various Send Fax
Manager tasks. Many of the commands can also be accessed using their corresponding
button on the toolbar.

■ Toolbar
The toolbar provides quick access for performing certain Send Fax Manager tasks. In
circumstances where a task is not possible, the toolbar button is unavailable, appearing
dimmed.

■ Faxes Sent Area
The Send Fax Manager shows you the status of your faxes, the fax recipient, its subject,
number of pages, and size. The job currently being processed — the active job — displays
at the top of the list. A job remains in the Send Fax Manager until it has been successfully
transmitted, or until you delete it.

■ Status Bar
You can display additional fax information in the status bar by selecting a job. When no job
is selected, the status bar displays information about all jobs.

Stop Delete

Open
Document

Help

Resend
Fax
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Job Status

One of the following statuses is assigned to each job in the Send Fax Manager.

■ Active
The active job is the job currently being PC faxed. When an active fax job completes
successfully, it is automatically moved to the Sent Fax folder or deleted (based on whether
you specified to delete after sending in the Send Fax dialog box).

■ Queued
A queued job is a job waiting to be PC faxed. Queued jobs are processed in chronological
order.

■ Scheduled
A scheduled job is a PC fax you specified to send at a later time.

■ Failed/Will Retry
A PC fax job receives this status if:

� The MultiPASS is busy with another task, and unable to transmit the PC fax.

� The receiving fax line is busy.

The Desktop Manager continues to try sending the fax until the transmission is successful
or the Desktop Manager exceeds the defined number of retries. If a job cannot complete
successfully within the specified number of retries, the job is marked with a Failed status.
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■ On Hold
A held job is a PC fax you chose to place on hold, rather than send it immediately.

■ Failed
A job receives a Failed status because a PC fax could not be sent successfully. This occurs
because the Desktop Manager exceeded the defined number of retries. For example, a PC
fax may have failed because of a continuously busy fax line or an incorrect fax number.

■ Stopped
A stopped job is a job that you stopped from being sent as a fax.

Stopping a Job from Faxing

If necessary, you can stop any job in the Send Fax Manager from faxing. When you do so, the
Desktop Manager retains the job in the Send Fax Manager as a stopped job. You can later send
or delete the job.

To stop a job:
1. In the Send Fax Manager, select the job you want to stop. To stop all the jobs, click Select

All on the Edit menu.

2. Once you have selected the desired job, click Stop on the Edit menu or toolbar.
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Sending a Held or Stopped PC Fax

At your convenience, you can send any held or stopped PC fax job that remains in the Send Fax
Manager. You can process the job for sending now or schedule it for a different time.

When you send a PC fax from the Send Fax Manager, the Send Fax dialog box displays the
information you initially entered for the PC fax. You can change the information as needed. For
example, for a stopped PC fax that failed because of a wrong fax number, you can correct the
fax number and resend it. Or, for a stopped PC fax that was scheduled for sending later, you can
specify a different time for transmission.

Additionally, if a cover page had been attached to the fax, you can edit any memo text or the
cover page styles.

To send a fax:
1. In the Send Fax Manager, select the job you want to send. Then, click Resend Fax on the

Fax menu or toolbar.

2. In the Send Fax dialog box, change any fax options as needed.

3. Process the fax:

� To process the fax for immediate sending, click Send Now.

� To schedule the fax for a later time, click Send Later.
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Viewing a Job

Documents in the Send Fax Manager can be viewed, but not edited or saved.

To view a document:
Do one of the following.

■ Select the job you want to view. Then click Open Document on the Fax menu or toolbar.

■ Double-click the job.

Deleting a Job

You can delete any job other than the Active job.

1. Select the job you want to delete. To select all the jobs, click Select All on the Edit menu.

2. Click Delete on the Edit menu or toolbar. Or, press the Delete key.
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Setting Up the Address Book
Setting up an Address Book creates an easily accessible list of names, fax and phone numbers,
and e-mail addresses for all of your business and personal contacts. Using the entries from the
Address Book makes sending a PC fax quick and easy.

To open the Address Book:
In the Desktop Manager window, click Address Book on the Tools menu or toolbar.
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Address Book entries are listed with the information you entered for each contact, such as first
and last name and fax number. You can sort the entries in the list based on the desired
information, such as the last name.

The status bar displays additional information for a selected Address Book entry, based on
whether the selected entry is an individual entry or group entry.

In setting up the Address Book, you can perform a variety of tasks, such as adding new
addresses, editing existing addresses, and importing or exporting the address entries.

Working With Address Book Entries

The Address Book contains the following types of entries:

■ Individual
An individual entry allows you to identify each individual to whom you frequently send PC
faxes. Once entered, you can then quickly specify the recipient of a PC fax by selecting them
from the Address Book.

■ Group
A group entry identifies two or more individual Address Book entries to whom you
repeatedly send the same PC fax. For example, you may want to set up a group to include
those individuals involved in a particular business project. When you specify the group
entry as the fax recipient on your PC fax, the PC fax is sent to each individual in the group.
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Sorting the Address Book

You can sort the entries in the Address Book in the order most convenient for you. To do so,
select the applicable heading for the column containing the information by which you want to
sort the list. For example, to sort the list by the last name, select the column heading Last.

Adding and Editing an Individual Address

When setting up an individual Address Book entry, at a minimum, you must specify the
contact’s first or last name, and a fax number. Optionally, if you want information available to
include on a fax cover page, you can enter the contact’s phone number, title, company name,
and address. You can also enter a comment to provide an internal reference about the recipient,
and an e-mail address.

To add or edit an individual entry:
1. With the Address Book open, select the desired command to add or edit an individual

entry:

� To add a new individual, click New Individual.

� To edit an individual record, select the entry in the list, and then click Edit.
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2. In the Individual Entry dialog box, enter or change the following information:

� First name, last name

� Phone number, fax number, and e-mail address

� Whether your primary preference is to use this listing for faxing or e-mail

� Company name
(if you want the information available for a fax cover page)

� Title, address, and comments
(as an internal reference)

� Use Outside Dialing Prefix
(Depending on the location of your fax recipient, you may need to use the dialing
prefix defined during installation or setup to access an outside line.)

3. Save your entry:

� If adding a new entry, click Add.

� If editing an existing entry, click Replace.

� To cancel without saving any entry or changes which may have been made, click
Cancel.
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Entering Fax Numbers and Phone Numbers
When you enter a fax or phone number, you use the actual numeric characters plus any valid
characters that separate the different segments of the number. For example, you can use 0
through 9, dash (–), and parentheses (). For a complete list of the characters that are valid in the
Desktop Manager, refer to Appendix A.

Do not include a prefix number if your phone system requires one to access an outside phone
line. If required, a prefix should be defined in the Desktop Manager Fax Setup dialog box.

Entering E-mail Addresses
You can enter your contact’s e-mail address for reference only. However, if you have a MAPI-
compliant e-mail application installed on your system (as described earlier in this chapter), you
can use the e-mail address to transmit a fax document as an e-mail message. The recipient’s
e-mail address provided in the Desktop Manager Address Book can be used only when
transmitting a document with the MultiPASS fax driver.

Adding and Editing a Group Address

A group address consists of previously set up addresses, either individual addresses or other
group addresses. When adding a new group, you assign a name to the group, and then select
previously defined addresses from the Address Book to include in the new group. When editing
an existing group address, you can add other addresses or delete addresses from the group.



Chapter 3 PC Faxing    3-38

To add or edit a group entry:
1. With the Address Book open, select the command to add or edit a group entry:

� To add a new group, click New Group.

� To edit a group, select the entry in the Address Book, and then click Edit.

2. In the New Group or Edit Group dialog box, in the Group Name box, enter or change the
name you want to assign to this group.

3. In the Address Book list, select the individual entry you want to add to the group, and then
click Add.
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4. Repeat step 3 for each individual or group you want to add to this group.

5. To remove an entry from the group, select the name in the group list, and then click
Remove.

6. Enter any desired internal reference comments for the group in the Comments box.

7. Save your entry:

� If adding a new group, click Create.

� If editing an existing group, click Replace.

� To cancel without saving any entry or changes which have been made, click Cancel.

Using a Group Address

When you specify a group address when sending a fax, the address for each individual
contained in the group is listed. If you specify more than one group address for a fax, and a
group contains the same individual address, the duplicate address is automatically removed.
Separate fax jobs are created for each recipient in the group, meaning you can create a single fax
and have it sent to multiple recipients.
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Deleting an Address Book Entry

When an entry in your Address Book is no longer needed, you can delete it in order to keep
your entries up to date.

To delete an entry, select the name in the Address Book. Then click Delete, or press the Delete
key. If prompted, confirm that you want to delete the entry.

Printing the Address Book

If you want a hard copy of the Address Book, you can print it.

1. With the Address Book open, click Print.

2. In the Print dialog box, specify your print options and click OK.

This report provides you with a hard copy of your Address Book information.

Importing the Address Book

You may have an existing address book, created by another application, containing the entries
you want to use for the Address Book in the Desktop Manager. In this event, you can import
your address book to the Desktop Manager.
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Any ASCII text file containing information that is separated by a comma or tab can be imported
into the Desktop Manager Address Book.

■ If the address information in the text file is separated by a comma, the text file extension
must be .CSV.

■ If the address information in the text file is separated by a tab, the text file extension must
be .TXT.

You must save your text file as a comma or tab separated text file before you import it into the
Desktop Manager. If you attempt to import information from an improperly formatted text file,
an error message displays alerting you to a problem and the import process stops.

For procedures on saving a text file in the correct format, refer to the user documentation for
your text file application.

When importing, you may need to add applicable fields or remove fields that do not appear in
the address book that you are importing. You can do this in the Edit Import/Export File Fields
dialog box. When you add fields, you select from the fields available in the MultiPASS Address
Book. Not all of those fields may appear in the address book file you are importing, however. In
this case, you may need to remove fields so that your imported file will be read correctly by the
MultiPASS Address Book.
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In addition, if the file fields in the address book that you want to import are in a different order,
you can change the order that the MultiPASS Address Book reads the fields. This prevents you
from having to manually edit your address book file to get the file fields in the right order. For
example, if the address book file lists the entries last name first, in the Edit Import/Export File
Fields dialog box, you can move the Last Name field up in the list so that it is first in the list of
file fields. As a result, your entries will be read correctly by the Address Book with the last name,
appearing in the last name field, instead of in the first name field.

To import addresses from a text file:
1. With the Address Book open, click Import.
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2. In the Import Address Book dialog box, specify the location of the file to be imported and
select the file type — .CSV file or .TXT file — in the Files of Type list.

3. Select the file you want to import, and then click Open.

4. In the Import/Export File Fields dialog box, select the address fields you want to import
from the Address Book Fields list:

� In the Address Book Fields box, select the field, and then click Add.

� To remove a field, in the File Fields list box, select the field, and then click Remove.

� To rearrange the order of the fields, select the field you want to move in the File Fields
box, and then click Move Up or Move Down.

5. Once you have the fields in the desired order, click OK.
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Exporting the Address Book

Address Book information can only be exported for individual entries. Group addresses cannot
be exported.

You can export the Address Book from the Desktop Manager as an ASCII text file. Exported
address information can be separated by either commas or tabs.

� If you want to have address information separated by commas, select to export to the
.CSV file format.

� If you want to have the address information in the text file separated by tabs, select to
export to the .TXT file format.

When you export a file from the Address Book, you can use the Import/Export File Fields dialog
box to specify the order that you want the file fields to appear in your saved file. For example, if
you wanted your entries to be listed first by their company name, last name, and then first
name, you would arrange the fields in the File Fields box in that order.

To export the Address Book:
1. With the Address Book open, click Export.

2. A message displays informing you that Group addresses cannot be exported. Click Yes to
close the message.
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3. In the Export Address Book dialog box, select how you want to export the address book, as
a .CSV file or as a .TXT file, in the Save as type list.

4. Specify the location where you want to export the file, specify a file name, and then click
Save.

5. Select the address fields you want to export from the Address Book Fields list box:

� Select the field in the Address Book Fields box, and then click Add.

� To remove a field, in the File Fields box, select the field, and then click Remove.

� To rearrange the order of the fields, select the field you want to move in the File Fields
box, and then click Move Up or Move Down.

6. Once you have the fields in the desired order, click OK.
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Designing a Fax Cover Page
In addition to the set of predefined fax cover pages that are automatically installed into your
system, you can also design your own fax cover page using the MultiPASS Cover Page Designer.
Additionally, any existing cover page — either installed with the Desktop Manager software or
created by you — can be edited and annotated with the Cover Page Designer.

When you create a new cover page, you define the page layout, background, graphics, and fax
information fields. Fax information fields — or variable fields — provide areas where recipient
and sender information for a specific fax can be placed. You can specify the size of the field, the
font, font size, and style of the text displayed for each variable.

You can use a new fax cover page by attaching it when sending a fax with the MultiPASS
Desktop Manager fax driver, or by printing a hard copy and using it when sending a fax directly
from the MultiPASS.

To open the Cover Page Designer:
1. In the Desktop Manager, point to Cover Pages on the Tools menu.

2. Click Cover Page Designer. Or click Cover Page Designer on the toolbar.

To close the Cover Page Designer:
In the Cover Page Designer window, click Exit on the File menu.
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Using the Cover Page Designer

This section provides an overview on the basics for using the Cover Page Designer. Detailed
instructions for using each of its various commands and components are covered in later
sections of this chapter.
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■ Menu Bar
The menu bar contains commands that allow you to create, edit, and print your fax cover
page. Many commands can also be accessed by corresponding buttons on the toolbars.

Some of the menu commands are also available on shortcut menus, which are displayed by
clicking the right mouse button in the Cover Page Designer window.

■ File Toolbar
The File toolbar provides you quick access to commands needed to open, save, copy, print,
and zoom a fax cover page.

■ Image Palette
The Image palette provides you quick access to commands needed to select, move, zoom, or
annotate a fax cover page.
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■ Image Toolbar
The Image toolbar provides quick access to commands needed to make various
adjustments to an image.

      

■ Annotation Toolbox
The Annotation toolbox allows you to add text and graphics to your cover page.
Annotations are integral elements of the cover page. Unless you select to “hide them,”
they are sent with the cover page, and can be printed, edited, and saved.

          

■ Data Fields (Variables Bin)
The Data Fields list contains the fields of information you may want to include on the fax
cover page. When you use the cover page with the Desktop Manager, these fields are
automatically filled in with the appropriate information for a specific fax transmission.
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Auto Color

Selection Arrow TextLine

Rectangle Ellipse Polygon

Free Drawing

Highlighter Stamp
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■ Layout Area
The layout area allows you to visually create and edit the features of your cover page. The
size of the layout area corresponds to the size of a standard fax page. You can use the
horizontal and vertical scroll bars to view different portions of the cover page, as necessary.

Creating a New Cover Page

The following instructions summarize the overall procedures for creating a new fax cover page.

To create a new fax cover page:
1. With the MultiPASS Cover Page Designer open, click New on the File menu.

2. Add text labels (such as To: and From:) and other desired text.

3. Insert the data fields you want to include using the options available in the Data Fields list.

4. Add any desired graphics (such as a company logo or signature).

5. Click Save on the File menu or toolbar.
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Importing a Cover Page Layout

You can create the layout for a cover page in another application (such as Word for Windows,
Paint, or Photoshop) and then import it as a TIFF file into the Cover Page Designer. Once
imported, you can add the data fields and edit any layout features as if you originally created the
cover page layout in the Cover Page Designer.

To import a cover page layout created in another application:
1. Create your cover page in the desired application and save it as a TIFF file.

2. With the Cover Page Designer open, click Import on the File menu.
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3. In the Select Image for New Cover Page dialog box, locate the cover page layout you want to
import and click Open.

You can now edit and save the cover page as desired.

Adding Labels and Text

You may want to add labels for the data fields you will be using (such as To: or From:) or other
text to your cover page using the Text tool on the Annotation toolbox. Once added, you can
select text attributes: font, font size and color, special effects (underline, strikeout), background
color and mode.

When selecting a font, font size, a color, or special effect, keep in mind that it affects the entire
text contained in the box. If you change any of the attributes while editing text, or while the text
box is selected, it changes all the text in the box.

To add text to the cover page:
1. Select the Annotations button on the Image toolbar.

2. On the Annotations toolbox, click the Text tool and drag the cursor to draw an
appropriately sized text box in the layout area.

3. Type the new text.
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To edit text:
1. On the Annotation toolbox, with the Selection tool selected, double-click the text you

added. The cursor changes to an insertion point.

2. Edit the text as needed.

Adding Variable Data Fields

You can insert variable fields that are filled in with actual data when you attach the cover page
to a particular fax. You can select any or all of the available fields, placing them at a desired
location in the layout area. Fields are placed on top of any cover page background or images.
Each field displays sample text to illustrate the current font, font size, and text attributes. Actual
data is added to the field when the fax is actually sent.

Only the variable fields shown in the Data Field list are available for you to use in the cover
page. You also cannot use a single field more than once on a cover page.

To insert a field:
1. Select the desired data field on the Data Field list.

2. Drag the cursor to draw an appropriately sized square or rectangle in the layout area.
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Adding Stamps

You can insert either a text or graphic image stamp on your cover page. The Desktop Manager
contains a library of available stamp images, stored as BMP files, that were installed with the
Desktop Manager software.  Additionally, you can add special graphics (such as a company logo
or personal signature) into the stamp library, provided the graphic is saved in a BMP format.

To add a new stamp to the library:
1. Click Select Stamp on the Annotation menu.

2. In the Image tab of the Select Stamp dialog box, click Add.
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3. In the Open dialog box, locate the BMP file you want to add to the Stamp library and click
Open.

4. If you have multiple graphics you want to add, repeat step 3.

To insert a stamp on the cover page:
1. In the Image Stamp tab of the Select Stamp dialog box, click the graphic you want to insert

into the cover page and click OK.

2. In the Cover Page Designer, select the Stamp tool on the Annotation toolbox.

3. Click the mouse at the location where you want to place the graphic in the layout area.

4. Adjust the size of the stamp as desired. To do so, click the Select Annotation tool from the
Annotation toolbox and then select the stamp in the layout area and drag any sizing handle.

Creating a Text Stamp
You can also create and use a text stamp on your cover page.

To create a text stamp:
1. Click Select Stamp on the Annotation menu.

2. In the Image Stamp tab of the Select Stamp dialog box, select the Text Stamp tab.
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3. Click Add on the Text Stamp tab.

4. In the Text Stamp Edit dialog box, type the text you want to assign to the Stamp in the
upper box.

� To add a date to the stamp, click Date. A code representing the date appears in the
upper box and the date is viewable in the lower preview box.

� To add the current time to the stamp, click Time. A code representing the time appears
in the upper box and the time is viewable in the lower preview box.

� To change the font and text characteristics of the text, click Font. In the Font dialog
box, specify your desired font type, style, size, and effects. Then click OK.

5. Click OK in the Text Stamp Edit dialog box to close the dialog box.
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6. Click OK again in the Select Stamp dialog box to close the dialog box and save the text
stamp.

To insert a text stamp:
1. Click Select Stamp on the Annotation menu.

2. In the Select Stamp dialog box, select the Text Stamp tab.

3. On the Text Stamp tab, select the text stamp you wish to insert into the cover page and click
OK.

4. In the Cover Page Designer window, on the Annotations menu, point to Tools and then
click Stamp. Or click Stamp in the Annotation toolbox.

5. Click the mouse at the location where you want to place the text stamp in the layout area.

To edit a text stamp:
1. Click Select Stamp on the Annotation menu.

2. In the Select Stamp dialog box, select the Text Stamp tab.

3. On the Text Stamp tab, select the stamp you want to edit, and then click Edit.

4. In the Text Stamp Edit dialog box, modify the text and click OK.

5. In the Select Stamp dialog box, click OK to save your changes and close the dialog box.
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To remove an image or text stamp:
1. Click Select Stamp on the Annotation menu.

2. In the Select Stamp dialog box, select the stamp you want to remove, and then click Delete.

3. When the confirmation message displays, click Yes.

4. In the Select Stamp dialog box, click OK to save your changes and close the dialog box.

Creating a Drawing Graphic

You can also annotate your cover page with one or more drawing objects that include a straight
line, a single-headed arrow, a hollow rectangle, and a hollow circle or ellipse. When you draw
the object, you can select the color, line thickness, and style of line for the object.

To create a drawing object:
1. On the Annotation toolbox, select the drawing object tool.

2. On the Annotation menu, select the color, line thickness, and style of line for the object you
are drawing. For an arrow or line, also select the particular style you want to use.

3. At the desired location in the layout area, drag the cursor to draw the object. When you
release the mouse button, the object is completed.
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Setting Preferences

You may want to set the following preferences in the Cover Page Designer to better suit your
working needs:

To set your preferences:
1. Click Preferences on the File menu.

2. In the Preferences dialog box, set the following options:

� Set the unit of measurement to Pixels, Inches, or Centimeters from the list.

� Click the Automatically Fit Window to Image option to automatically resize the
window to your image when you make any change.

� Click High Quality When Zooming to maintain a high display quality when your
document or cover page is magnified.

3. Click OK to save your changes and close the Preferences dialog box.

To display rulers:
Click Show Rulers on the View menu.
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Adjusting Text and Variable Fields

Once you have placed the desired text labels and variable fields into the layout area, you can
adjust the appearance of any text or data field. You can resize, move, or delete text or data fields.

Additionally, you can set the text attributes for text or data fields and align two or more fields
on the right, left, top, or bottom.

To select text or data fields in the layout area:
■ To select a single text box or data field, click the Select tool on the Annotations toolbox, and

then select the text box or data field.

■ To select more than one text box or data field, hold down the Shift key and select the
desired text and/or data fields.

To move text or data fields:
Drag the selected text box or data field to the new location.

To delete a text box or data field:
Select the text box or data field and press the Delete key.
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Resizing a Field

With the exception of the Memo field, most of the variable fields consist of a single line of text.
If the variable information to be placed in the field is longer than the field size, the text does not
automatically wrap onto the next line. Instead, the text is truncated to fit the length of the field.
For this reason, you may want to resize fields to ensure that the full line of text is visible on the
cover page when the fax is sent.

Since the Memo field typically contains multiple text lines, the field does provide for automatic
text wrapping. However, make sure the size of the Memo field is large enough to accommodate
the length of memo text that may be entered in the Send Fax dialog box. If the Memo field is
not large enough, all the lines of a memo text may not be visible when the fax cover page is sent.

To resize the field:
Select the field and drag any sizing handle.

Changing Text Attributes

Once you have placed text labels and fields in the layout area, you can change the font and font
size of the text, select a text style (bold, italic, underline), or change the font color. If you have
multiple fields to which you want to assign the same attributes, you can select the fields together
and make the change to all the selected fields at once.
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To change text attributes:
1. In the layout area, select the labels or fields you want to change.

2. Click Select Font on the Annotation menu.

3. In the Font dialog box, select the appropriate text attributes. (Notice that a sample of your
selections is displayed in the Sample box.)

4. Click OK to apply the settings.
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To change text color:
1. In the layout area, select the fields you want to change.

2. Point to Foreground Color on the Annotation menu. Then select the desired color on the
displayed menu.

Aligning Fields

When placing labels, graphics or variable fields in the layout area, you may be concerned that
they properly align, to make them more visually appealing. You can align two or more selected
fields, based on the position of the first field you select. The first field selected in the set of fields
to be aligned is the anchor for the alignment.

You can align fields, based on the first selected field, by their top, bottom, left, or right border.

You can also center the fields horizontally with one another, in a row, or vertically with one
another in a column.

To align fields:
1. Select the two or more fields you want to align.

2. Point to Align on the Annotation menu. Then select the desired alignment.
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Adjusting the Orientation of the Layout

When creating or editing a cover page, you may want to adjust your view of the layout. You can
rotate the base page clockwise by selected increments. You can also flip the layout vertically
(flipping the layout elements from top to bottom or vice versa) or horizontally (flipping the
layout from left and right).

To rotate the cover page:
On the Edit menu, point to Rotate, and then select 90, 180, or 270.

To flip the layout:
On the Edit menu, point to Flip. Then click Horizontal or Vertical.

Straightening a Cover Page Layout

In designing a cover page, you may need to straighten the base image before you begin adding
text or graphics to it. For example, you may have imported a scanned image for the cover page
layout, that was not perfectly straight.
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To straighten a document:
1. On the Image toolbar, click the Straighten button.

  

2. On the Straighten toolbar, click the Rotate Clockwise or Rotate Counter Clockwise button
to rotate the crosshairs until it aligns with the layout image.

3. Click the Straighten button to have the system adjust the layout image to its properly
aligned position.

Adjusting the Display

The Cover Page Designer provides you with different levels of magnification allowing you to
work at the most comfortable size. You can zoom in and out at predefined increments, or
specify a particular size or scale. You can also adjust the document image size so that the entire
cover page is visible within the window.

Rotate
Clockwise

Rotate Counter
Clockwise

Straighten
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To zoom in or zoom out on the cover page:
Do one of the following:

■ On the View menu, point to Zoom, and then select the desired level of magnification.

■ On the File toolbar, select the desired level of magnification in the list.

■ On the Image palette, select the Zoom tool, and then:

� To increase magnification, select the document.

� To decrease magnification, hold down the Alt key, and select the document.

To fit the cover page to the display window:
Click Fit Image to Window on the View menu.

Scrolling Through a Zoomed Cover Page

If you need to work on particular aspects of a cover page (for example, to modify a recurring
graphic), you can scroll through the cover page while maintaining a high level of magnification.
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To scroll through a zoomed cover page:
1. Click Show Navigator on the View menu. The Navigator window opens in the right corner

of the screen.

Inside the Navigator, a white rectangle indicates the area of your cover page that is currently
in view.

2. On the Image palette, click Move.

3. While tracking your position in the Navigator window, drag the image to bring the desired
area of the cover page into view.
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Editing a Selected Area of the Layout

While working with a cover page, you may need to edit the base cover page that underlies all
annotations. When editing a base cover page, you can select, crop, or flip a specific area. For
example, to create a novel effect, you may want to flip an imbedded graphic on its vertical or
horizontal axis.

To select an area of a cover page:
1. On the Image palette:

� Select the Select tool for areas that fit easily inside a square or rectangle.

� Select the Lasso tool for irregularly shaped areas.

2. Drag the cursor to draw the appropriately shaped outline for the area you want to select.

To crop a cover page:
1. Select the area of the cover page to which you want the entire cover page to conform.

2. Click Crop Inplace on the Edit menu or toolbar.

To flip a selected area of a cover page:
1. Select an area of the cover page.

2. Point to Flip on the Edit menu, and then click Horizontal or Vertical.
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Adjusting the Size of a Cover Page

Adjusting the size of a cover page can be useful in planning other tasks. For example, if a
document consists solely of a large graphic, you may want to reduce its size so that it can be
used later in creating a background for another cover page.

Changing the size of a document involves changing the number of pixels used to represent it.
Such a change permanently alters the document file.

To adjust the size of a cover page:
1. Click Image Size on the Adjust menu.
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2. In the Image Size dialog box, enter the dimensions of the newly sized document.

3. Click OK. The document file is resized.

Adjusting the Image Type

You can adjust the type of image for the cover page layout.

To adjust the image type:
1. Point to Image Type on the Adjust menu.

2. Select one of the following image types:

� True Color
True Color images contain 8 bits per pixel for red, green, and blue channels. Each pixel
contains 24 bits.

� Grayscale
Grayscale images contain 8 bits per pixel.
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� Black and White
Select one of the following:

Binary: Images are one bit per pixel.

Half Tone: Simulates the tonal range of an image with a precise pattern of lines and
dots.

Text Enhanced: Images are grayscale images (8 bits per pixel) converted to binary
images (1 bit per pixel) using Canon ImageTrust technology.

Making Image Adjustments

Adjustment features allow you to make adjustments to the cover page including contrast,
brightness, sharpness, and cleanup. You can produce a wide range of visual changes in your
cover page.

Image adjustment options are only available when you select True Color or Grayscale as your
image type.
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Adjusting Color and Color Level Automatically

You can have the system automatically adjust the color and color level for better viewing with
your computer monitor or other output device.

To adjust the color level automatically:
Click Auto Level on the Adjust menu to adjust the color level of your cover page.

To adjust the color automatically:
Click Auto Color on the Adjust menu to adjust the color of your cover page.

Adjusting Brightness and Contrast

You can adjust the brightness and contrast of a color or grayscale image.

To adjust the brightness and contrast:
1. Select the cover page or a portion of the cover page.

2. On the Adjust menu, click Brightness and Contrast.
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In the Brightness and Contrast dialog box, the original cover page appears on the left of the
dialog box. As you modify the cover page, you can see the results in the image on the right.

3. Move the Brightness slider to the left to make the cover page darker, to the right to make
the cover page brighter.

4. Move the Contrast slider to the left to decrease contrast, to the right to increase contrast.

5. When the current cover page appears as you want it, click OK to accept the changes. Click
Cancel to abandon the changes.
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Adjusting the Color Balance

You can adjust the color components of a cover page by changing the level of red, green, and
blue colors that make up the shades in your cover page.

To adjust the color balance:
1. Select the cover page or a portion of the cover page.

2. On the Adjust menu, click Color Balance.
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3. In the Color Balance dialog box, move the Red, Green, and Blue sliders to the left for less
color, to the right for more color.

As you modify the cover page, you can see the results in the cover page on the right.

4. When the current image appears as you want it, click OK to accept the changes.  Click
Cancel to abandon the changes.

Setting the Black Point and White Point

If you are not satisfied with the results of the Auto Level or Brightness & Contrast features, you
may want to first manually define the contrast range of the cover page by setting the image
highlight and shadow points, or the black point and white point. With this method, you specify
what you consider to be the important highlight and shadow details. You can select the darkest
point and the lightest point to more effectively adjust the image contrast with Auto Level or the
Brightness & Contrast features. When adjusting the image level, these points define the lightest
and darkest points of the range when you adjust the image contrast.
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To set the Black Point and White Point:
1. Select the cover page or a cover page portion.

2. On the Adjust menu, click Black Point/White Point.

3. In the Black Point/White Point dialog box, click Black Point.

4. Move the pointer over the Original thumbnail. As you move the pointer over the cover
page, the black value, expressed as a percentage of the current pixel, appears to the left of
the Black Point button.

5. Move the pointer over the cover page until you find the blackest point. This point will have
the value closest to 0%. Select the pixel.
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6. Click White Point.

7. Move the pointer over the Original thumbnail. As you move the pointer over the cover
page, the white value, expressed as a percentage of the current pixel, appears to the left of
the White Point button.

8. Move the pointer over the cover page until you find the whitest point. This is the point with
the value closest to 100%. Select the pixel.

9. Click OK.

Blurring an Image

You can blur the cover page to soften the edges and fields of a grainy  color or grayscale image.
Blur averages the color values of adjacent pixels, removing peaks, to make the cover page
smoother.
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To blur an image:
1. Select the cover page or a cover page portion.

2. On the Adjust menu, select Blur.

3. In the Blur dialog box, move the Blur slider to the left for less blur, to the right for more
blur.

As you move the slider, the adjustments appear in the Current thumbnail.

4. Click OK to accept the changes. Click Cancel to abandon the changes.
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Sharpening an Image

You can sharpen a cover page to increase the difference between color values of adjacent pixels,
sharpening the appearance of a color or grayscale cover page.

To sharpen an image:
1. Select the cover page or a cover page portion.

2. On the Adjust menu, click Sharpen.

3. In the Sharpen dialog box, move the Sharpen slider to the left to sharpen less, to the right to
sharpen more.

As you move the slider, the adjustments appear in the Current thumbnail.

4. Click OK to accept the changes. Click Cancel to abandon the changes.
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Removing Noise

You can remove noise or distortions from the cover page. The Remove Noise filter averages the
color values of adjacent pixels.

To remove noise:
1. On the Adjust menu, point to Advanced, and then click Remove Noise.

2. Drag the Removal slider to the left to remove less noise, to the right to remove more noise.

As you drag the Removal slider, your changes appear in the Current thumbnail. You can
compare the changes to the Original thumbnail.

3. Click OK to accept your changes. Click Cancel to leave the cover page unchanged.
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Removing Moire Patterns

You can remove moire patterns from a cover page. Because moire patterns are caused by the
intersection of lines in two directions, removing the pattern requires the following procedure to
be performed twice, resetting the angle option for each set of intersecting lines.

To remove moire patterns:
1. Select the cover page area where the pattern occurs.

2. On the Adjust menu, point to Advanced, and then click Remove Moire.
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3. In the Angle box, enter the angle of the moire lines to be removed.

4. Drag the Remove Moire slider to the left to remove less, to the right to remove more.

As you make changes to the image, your changes appear in the current thumbnail. You can
compare the changes to the Original thumbnail.

To better see your changes, you can use the zoom buttons to magnify the thumbnails.

5. Click OK to accept your changes. Click Cancel to leave the cover page unchanged.

Removing JPEG Artifacts

JPEG images that have been compressed using maximum compression may display scattered
noise, called JPEG artifacts, around the image edges. You can remove these distortions.

To remove JPEG artifacts:
1. Select the area of the cover page where the artifacts occur.
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2. On the Adjust menu, point to Advanced, and then click Remove JPEG Artifacts.

3. In the Remove JPEG Artifacts dialog box, drag the Removal slider to the left to remove less,
to the right to remove more.

As you make changes to the cover page, your changes appear in the current thumbnail. You
can compare the changes to the Original thumbnail.

To better see your changes, you can use the zoom buttons to magnify the thumbnails.

4. Click OK to accept your changes. Click Cancel to leave the cover page unchanged.
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Removing Show-Through

Image show-through is caused by patterns from the reverse side of a page showing through the
original image. You can remove image show-through while preserving the image.

To remove show-through:
1. Select the cover page portion you want to adjust.

2. On the Adjust menu, point to Advanced, and then click Remove Show-Through.
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3. In the Remove Show-Through dialog box, use the Range slider to adjust Removal slider
sensitivity according to the contrast of the pixels showing through to the background.

If there is a wide range between color, move the Range slider to the right. If there is little
range between the pixels showing through and the background, move the slider to the left.

4. Drag the Removal slider to the left to remove less show-through, to the right to remove
more show-through.

5. Click OK to accept your changes. Click Cancel to leave the cover page unchanged.

Removing Dust

Even if you have carefully cleaned the original cover page, there may be some dust on the image.
Dust leaves small spots on your image, usually one or two pixels in size. You can easily remove
dust or any small speckles from an image, by blending the color of the dots with the adjacent
pixels. You can control the degree of blending.

To remove dust:
1. Select the area of the cover page where the dust appears.

2. On the Adjust menu, point to Advanced, and then click Remove Dust.



Chapter 3 PC Faxing    3-86

3. In the Remove Dust dialog box, click Dark and/or Light, depending on the color of the
dust.

4. Drag the Threshold slider according to the deviation of the dust from dark to light.

5. Drag the Removal slider to the left to remove less dust or to the right to remove more dust.

Moving the slider to the right blends the dust more with the background color that
surrounds the dust. As you drag the Removal slider, your changes appear in the Current
thumbnail. You can compare the changes to the Original thumbnail.

You can also use the zoom buttons to magnify the thumbnails.

6. Click OK to accept your changes. Click Cancel to leave the cover page unchanged.



Chapter 3 PC Faxing    3-87

Removing Scanner Noise

You can remove distortions associated with scanned images, such as color bands and streaks.

To remove scanner noise:
1. Select the area of the cover page where the scanner noise appears.

2. On the Adjust menu, point to Advanced, and then click Remove Scanner Noise.

3. In the Remove Scanner Noise dialog box, select Vertical or Horizontal according to the
direction of the streaks or bands.
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4. Drag the slider to the left to remove less noise, to the right to remove more noise.

As you drag the slider, your changes appear in the Current thumbnail. You can compare the
changes to the Original thumbnail.

You can also use the zoom buttons to magnify the thumbnails.

5. Click OK to accept your changes. Click Cancel to leave the cover page unchanged.

Adding Annotations to Your Cover Page

The following sections describe additional ways in which you can annotate your cover page.

Adding a Sticky-Note

Rather than add text directly to a cover page, as you do with the Text tool, you can add a sticky-
note on any portion of your cover page as a graphic element.

When you add a sticky-note, you can select the text attributes: font, font size and color,
background color, and special effects (underline, strikeout).

You can type any text that you want for the sticky-note, editing the note later if necessary. If you
select a font, font size, a color, or special effect, it affects the entire note. If you change any of the
attributes while editing a note, or while the note is selected, it changes all the text in the note.
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To add a sticky-note:
1. On the Annotations toolbox, select the Sticky-Note tool and drag the cursor to draw an

appropriately sized square or rectangle.

2. Type the text of your note.

To edit sticky-note text:
1. On the Annotation Toolbar, with the Selection tool selected, double-click the sticky-note.

The cursor changes to an insertion point.

2. Edit the text as needed.

3. Click anywhere outside the sticky-note to save your changes.

To change the font and color:
1. Select the sticky-note.

2. To set font properties for the text, on the Annotations menu, click Select Font. In the Font
dialog box, select the font attributes and click OK.

3. To set a background color for the sticky-note, on the Annotations menu, point to
Background Color. Then click the desired color on the displayed menu.
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Highlighting Your Cover Page

You can add a color highlight to text or other images in your cover page. To do this, select a
color and then draw a rectangular highlight over the desired area. All highlight colors are
transparent and display in the color you specify. When you print the document, the highlighted
region prints as gray shadings.

To highlight a region:
1. On the Annotations toolbox, select the Highlighter tool.

2. To select a highlighting background color, point to Background Color on the Annotation
menu, and then select the desired color.

3. Drag the cursor over the area you want to highlight. When you release the mouse button,
the highlight is completed.

Removing an Annotation

If you decide you no longer want an item to appear in your cover page, you can remove it
permanently by selecting it and pressing the Delete key.
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Copying a Field or an Annotation

You can copy a field or graphic item and paste it into another Windows application which
supports a Paste option. When you copy a field or graphic item, it is placed in the clipboard.

To copy a field or graphic element:
With the element to be copied selected, click Copy on the Edit menu or toolbar.

Opening and Modifying a Fax Cover Page

When you open a new cover page, you select from a list of available templates. You can then
make adjustments and annotations to the cover page in the Cover Page Designer.

The following instructions summarize the basic procedures for opening and modifying a cover
page. Detailed procedures for modifying a cover page follow this summary.
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To open and modify a fax cover page:
1. With the Cover Page Designer open, click Open on the File menu or toolbar.

2. In the Select Title dialog box, select the desired fax cover sheet and click OK.

3. Make the appropriate adjustments, such as:

� Adjust the text and variable fields.

� Adjust the cover page layout.

� Adjust the document size and type.

� Make image adjustments.

� Add additional annotations.

4. Click Save on the File menu to save your changes.
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Reverting to the Last Saved Version

If you are dissatisfied with changes that you have made to your cover page, you can discard
them and return to the last saved version.

To revert to the last saved version:
Click Revert to Original on the File menu. When the confirmation message displays, click Yes.

Printing a Cover Page

You print a cover page for previewing a newly designed cover page. The printed cover page can
also be used when sending a fax directly with the MultiPASS.

To print a cover page:
1. In the Cover Page Designer, click Print on the File menu or toolbar.

2. In the Print dialog box, specify the desired print options and click OK.
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Renaming a Cover Page

You can rename a cover page at any time in the Desktop Manager.

To rename a cover page:
1. In the Desktop Manager, on the Tools menu, point to Cover Pages. Then click Manage

Cover Pages.
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2. In the Manage Cover Page List dialog box, select the cover page you want to rename and
click Rename.

3. In the Rename dialog box, type the new name for the cover page and click OK.

4. In the Manage Cover Page List dialog box, click OK to save your changes and close the
dialog box.

Deleting a Cover Page

You can delete a cover page that you no longer need from the Desktop Manager.

To delete a cover page:
1. In the Desktop Manager, on the Tools menu, point to Cover Pages. Then click Manage

Cover Pages.
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2. In the Manage Cover Page List dialog box, select the cover page you want to delete and click
Delete.

When the confirmation message appears, click Yes.

3. In the Manage Cover Page List dialog box, click OK to close the dialog box.

Faxing With Your E-Mail Application
From your e-mail application you can send a document using the MultiPASS Fax Driver. This
feature is possible with any MAPI-compliant application such as Microsoft Exchange or
Microsoft Outlook 97 or later.

To send and receive faxes as e-mail messages, you must set up MultiPASS Fax as a profile in your
e-mail application in Windows. This setup automatically provides the Desktop Manager
Address Book in your e-mail application. To send a fax, you must use the fax information you
define in the Desktop Manager Address Book. Although the address book for your e-mail
application may allow you to define fax information, this fax information cannot be used by the
MultiPASS system for sending a fax. Additionally, any e-mail address information you may have
set up in the Desktop Manager Address Book cannot be used by your e-mail application for
sending an e-mail message.
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Once you set up the MultiPASS Fax profile in your e-mail application, all incoming faxes can be
received automatically in both the Desktop Manager and your e-mail application. However, if
your MultiPASS is set to print faxes, rather than upload them to your computer, incoming faxes
are not received in the Desktop Manager or your e-mail application.

Setting Up MultiPASS Fax in Your E-mail Application

This section provides summarized instructions for setting up MultiPASS Fax in the e-mail
application. For details, see your Windows documentation.

To set up MultiPASS Fax in your e-mail application:
1. In Windows Control Panel, double-click the Mail icon.

2. In the Profile Properties dialog box, click Show Profiles.

3. In the Mail dialog box, on the General tab, click Properties.

4. In the Properties dialog box, click Add.

5. In the Add Service to Profile dialog box, click Canon MultiPASS Fax. Then click OK.

The MultiPASS Desktop Manager Address Book is available to your e-mail application for
sending a message as a fax.
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Sending an E-mail Message as a Fax

Once you have set up MultiPASS Fax in your e-mail application, you can send an e-mail
message as a fax with the MultiPASS printer.

To send an e-mail message as a fax:
1. In your e-mail application, create a new message as usual.

2. Select an address, containing the fax information, from the MultiPASS Desktop Manager
Address Book.

3. Create the e-mail message as usual.

4. Click the command to send the message.

Based on your setup options in your e-mail application, your message may be stored in a sent
items folder. The fax is also recorded in the MultiPASS Desktop Manager Fax Log and Inbox
folder.
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Receiving a Fax

Once you have set up MultiPASS Fax in your e-mail application, incoming faxes are
automatically received in your e-mail application in the Inbox folder (unless you set the
MultiPASS to print faxes instead).

When you reply to a received fax in your e-mail application, the response is sent as a fax to the
original sender.
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Chapter 4
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Scanning Overview
You can use the MultiPASS to scan documents from the Desktop Manager, or from any
TWAIN-compliant Windows application.

When you scan a document in the Desktop Manager, the ScanGear window displays, allowing
you to set certain scanning options and conditions. This chapter provides instructions on
setting scan options using the ScanGear window.

When you scan a document in a Windows application, the application may or may not display
the ScanGear window. If the ScanGear window is not displayed, refer to the documentation for
the Windows application you are working in for instructions on setting scan options.

Typically, when you scan a document using the ScanGear window, you first scan a preview of
the document. The preview image enables you to review the results of your scanned document
and make any necessary adjustments (for example, to size, tone, and so on). When you are
satisfied with the results, you then perform the final scan of the document. The system then
places the final image into the Desktop Manager or your Windows application.
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Features of the ScanGear Window

This section provides an overview of the basics of the ScanGear window. Detailed instructions
for using the various commands and components of the window are provided in later sections
of this chapter.
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■ Toolbar
The toolbar provides buttons for performing certain tasks when scanning. In circumstances
where a task is not possible, the toolbar button is unavailable, appearing dimmed.

                    

■ Preview Area
The preview area displays a preview image of the document you scan. A preview image
enables you to adjust various document characteristics before you perform the final scan.
For example, you can make adjustments to the size, the orientation, or the tone of the
image.

■ Scan Option Tabs
The Scan Option tabs provide adjustment options when performing a preview or final
scan.

■ Status Bar
The status bar displays information on the scan process status. This information can
include the scan mode, scan resolution, size (width and height), and the resulting file size
of the scanned image.
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Displaying Information About the Scan Driver

You can display version and copyright information about the scan driver using the About dialog
box.

1. On the title bar in the ScanGear window, click the right mouse button.

2. On the displayed menu, click About ScanGear.

3. To close the dialog box, click OK.

Scanning With the Desktop Manager
You can use the MultiPASS and the Desktop Manager to scan a color or monochrome image.
The resulting document is displayed in the Desktop Manager and is automatically provided
with a unique system-assigned name. You can rename the document later as desired.

Each image you scan is placed into the Scan folder as a TIFF document. A scanned document
remains in the Scan folder until you move it, or delete it. A scanned document can be reviewed,
annotated, printed, sent as a fax, or attached to an e-mail message. For more information on
these tasks, refer to Chapter 5, Working With Documents.
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The following instructions summarize the overall procedures for scanning an image.

To scan an image using the Desktop Manager:
1. Place the image you want to scan face down in the ADF (automatic document feeder) of

the MultiPASS.

2. In the Desktop Manager, click Scan on the Tools menu or toolbar.

3. In the ScanGear window, specify the appropriate preview scan options for your document
as necessary, such as Scan Mode, Scan Resolution, Preferences, Page Size, and Black and
White options (if applicable).

4. Click Preview.

5. Review the display of the scanned preview image in the scan window. Adjust the properties
of your image as necessary.

6. Replace your document in the document feeder of the MultiPASS.

7. Click Scan.

An indicator displays to track the progress of the scan. Once complete, the image is stored in the
Scan folder, where it remains until you move or delete it.
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Scanning From a Windows Application
You can use the MultiPASS to scan documents directly into a Windows application that
supports a TWAIN interface (such as Photoshop). Some applications allow multiple page scans,
while others do not. If you are unsure whether your Windows application supports this feature,
refer to the user documentation for the application you are using.

The following instructions summarize the general procedures for scanning an image. For
specific information on scanning with your Windows application and specifying MultiPASS as
the scan device, refer to the user documentation for the application you are using.

To scan an image from a Windows application:
1. Place the image you want to scan face down in the Automatic Document Feeder (ADF) of

the MultiPASS.

2. In your Windows application, select the command to scan a document.

In some applications, the appropriate command may be listed as Acquire or Acquire
Image.

3. In the ScanGear window, specify the following preview scan options for your document as
necessary: Scan Mode, Scan Resolution, Preferences, Page Size, and Black and White
Options (if applicable).

4. Click Preview.
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5. Review the display of your scanned preview image. Adjust the properties of the image as
necessary.

6. Replace your document in the document feeder of the MultiPASS.

7. Click Scan.

When complete, the image appears in the display area of your Windows application.

Setting the Preview Scan Options
Before previewing a scan, set the scan mode, resolution, preferences, and paper size.
Additionally, when you are scanning a black and white image, you can select one of the two
black and white options.
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Setting the Scan Mode

For a preview image, you specify how your source image will be acquired. Your options include
the following:

■ Black and White
Black and white images are scanned at one bit per pixel. For applications that request a
black and white scan and do not use the scan driver window, the scan driver automatically
uses the Text Enhanced setting if you selected the Use Text Enhanced option in the
Preferences tab. For details, refer to the “Setting Preferences” section in this chapter.

■ Grayscale
Grayscale images contain 8 bits per pixel.

■ Color
Color images contain 8 bits per pixel for red, green, and blue channels. Each pixel contains
24 bits.

■ Text Enhanced
Text enhanced images are grayscale images (8 bits per pixel) converted to black and white
(1 bit per pixel) using Canon ImageTrust technology.
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To set the scan mode:
1. Select the Main tab.

2. In the Scan Mode list, select the desired option.
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Setting the Scan Resolution

You can set the resolution of a scanned image based on the selected output device. This
resolution becomes the base on which changes to image size and scale are calculated. You can
select a preset resolution, or create a custom resolution.

To set the scan resolution with a preset option:
1. Select the Main tab.

2. In the Scan Resolution list, select the desired option.

Creating a Custom Resolution

You can define a custom resolution, change an existing custom resolution, or delete a previously
defined custom resolution.
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To create a custom scan resolution:
1. In the Scan Resolution list, click Custom.

2. In the Custom Resolutions dialog box, type a name for your custom resolution setting.

3. In the Resolution text box, enter the preferred dpi setting.

4. Click Add. The new resolution name displays in the Resolution List.

5. Click OK to add the resolution setting.

Click Cancel to close the dialog box without adding the custom resolution.
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Deleting a Custom Resolution

When you no longer need to use a custom resolution, you can delete it from the list. You cannot
remove or replace the preset resolution settings.

To delete a custom resolution:
1. In the Scan Resolution list, click Custom.

2. In the Custom Resolutions dialog box, in the Name list, select the custom resolution setting
you want to delete.

3. Click Remove.

4. Click OK to remove the resolution setting.

Click Cancel to close the dialog box without removing the custom resolution setting.
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Changing a Custom Resolution

Once you have set a custom resolution, you can change it at any time as necessary.

To change a custom resolution:
1. In the Scan Resolution list, click Custom.

2. In the Custom Resolutions dialog box, in the Name list, select an existing custom
resolution.

3. In the Name and/or Resolution text boxes, enter the desired change.

4. Click Replace. The updated custom resolution displays in the Resolution List, replacing the
existing one.

5. Click OK to save your changes to the resolution setting.

Click Cancel to close the dialog box without saving your changes.
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Setting Preferences

You can select a preference that governs how your source image is scanned using the Preferences
tab.
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To set a preference:
On the Preferences tab, click the desired preference check box. You can select from the following
options:

■ Text Enhanced
This option is designed for use with OCR (Optical Character Recognition) software. This
setting increases the contrast in black and white scanning to promote the accurate
recognition of characters in OCR software. Resolution should be at least 300 dpi for OCR
scans.

If selected, the text enhanced setting is used for applications that request a black and white
scan and do not use the scan window (including most OCR applications).

■ Color Matching
This option enables your display to show an image in colors that best represent the original,
by taking into account the display characteristics of your monitor. If selected, the system
uses the color profiles specified in the Color Management tabs of the scanner and monitor
properties.

Since results can vary, it is recommended that you experiment scanning your image with
this option turned on and off. Results can vary based on the type of image you are scanning
and the output of your final scan.
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■ Change Monitor Profile
Different monitors display colors differently. ScanGear’s Color Matching enables your
system to display colors that best match the colors scanned based on the type of monitor
identified in the Windows Control Panel.

To change your monitor profile:
1. Click the Change Monitor Profile button.

2. In the displayed monitor list, select your monitor. If your monitor is not listed, select
Canon’s RGB v.1.10.

Setting Paper Size

You select a paper size that corresponds to the size of your source document. If your document
does not conform to one of the available sizes, you can define a custom paper size.
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To select a standard paper size:
1. Select the C530 (or C560) tab.

2. In the Paper Size list, select the desired option.

To set a custom paper size:
1. Select the C530 (or C560) tab.

2. In the Paper Size list, click Custom.
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3. In the Units list, select the unit of measure by which you want to define your custom size.

4. In the Width and Length text boxes, enter the dimensions of your source document.

Setting Black and White Options

If you select black and white as your scan mode, you can also select one of the following black
and white options from the C530 (or C560) tab:

■ Threshold
The Threshold option provides a high contrast evaluation of the image in terms of blacks
and whites only. This option is useful when scanning documents with text.

■ Halftone
The Halftone option simulates the tonal range of an image with a precise pattern of lines
and dots. This option is useful when scanning documents with many shades of gray.
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To set a black and white option:
1. Select the C530 (or C560) tab.

2. In the Black & White Options list, click Threshold or Halftone.

Adjusting the Preview Image for Final Scan
Once an image has been previewed, you can adjust it, as necessary, for the final scan by
changing its selection size, its output size, aspects of its orientation, or aspects of its tone. For
information on adjusting the tone of the preview image, see the “Adjusting the Tone of the
Preview Image” section.
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Clearing the Preview Area

If the preview image does not serve your purpose, you can quickly remove it from the preview
area and rescan the image.

To remove the current preview image:
On the toolbar, click Clear Preview.

Adjusting the Preview Image View

To make it easier to work with your preview image, you can change aspects of its display.

Changing the View Size

You can enlarge a preview image to better view its details. Each enlargement doubles the size of
the image up to a maximum of 4 times the size of the original image.

As you enlarged the image, you can just as easily reduce it. Each reduction decreases the size of
the image by one-half.

To resize a preview image:
1. On the toolbar, click Zoom.

2. To enlarge, left-click the mouse pointer on the image.

To reduce, right-click the mouse pointer on the image.
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Displaying Rulers

To work precisely with a preview image, you can display rulers on the top and left borders of the
preview area. The rulers display based on what you have set as the unit of measure on the Main
tab.

To display rulers:
On the toolbar, click Rulers.

Adjusting the Selection Size

When you first preview an image, the selection size is the same as your source document paper
size.

You can adjust the selection size of an image in order to isolate a specific area of the image for a
more selective preview scan. For example, in scanning a letter, you may want to isolate and save
a company logo by itself, ignoring the rest of the letter.

You define the selection size of your image by drawing a border around the part of the image
that you would like to isolate. Alternatively, you can define and orient the dimensions of the
selection with respect to the upper left corner of the preview area. Regardless of how you define
a selection, you can easily and quickly change its dimensions.
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In defining the selection size, regardless of the method you select, you can maintain the current
height and width proportions of the image.

For example, you set the width to four inches and the height to six inches. You change the width
to five inches. If Keep Proportions is not selected, the height remains the same. Thus, the
proportion of the page height and width changes. If Keep Proportions is selected when you
change the width, the height automatically changes. The lock icon indicates that the page size
will be maintained in the same proportion whenever you change either the width or the height.

To adjust the selection size:
1. Select the Main tab.

2. If you want to preserve the current proportions of the image, click the Keep Proportions
button.

3. To draw the selected area, click Crop on the toolbar and drag the mouse diagonally across
the area of the image in the preview window you want to select. The Width and Height text
boxes display the new sizes.

Keep Proportions Button
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4. To further define the dimensions of the selected area, in the Width and Height text boxes,
type the appropriate values. The image selection borders change to match the specified
width and height.

5. If you want to select an entirely different area of the image, click outside the crop lines to
clear the current selection.

6. To preview the newly selected image area, click Preview.

Moving an Image

If the image is too large to see in its entirety, you can move the image within the preview area to
locate a relevant section.

To move an enlarged image:
On the toolbar, click Move Image and drag the zoomed image to display the appropriate area or
detail.

Reversing the Image Tone

You can create a negative of an image for stylistic effect. A negative image is created by inverting
the dark and light areas.

To reverse the tone of an image:
On the toolbar, click Negative/Positive.
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Mirroring an Image

By mirroring an image, you can create an alternate version. For example, you can create an
alternate version of your company logo.

To create a mirror image of the preview image:
On the toolbar, click Mirror.

Rotating an Image

You can rotate an image 90° left or right within the preview area to change its orientation. When
you rotate an image, the entire preview area, including the rulers, rotates. For example, if the
preview area is in portrait orientation, it becomes landscape.

To rotate a preview image:
On the toolbar, click Rotate Left or Rotate Right.

Scaling the Image Output Size

You can scale the preview image to better fit your needs. For example, if you reduce by 50% the
scale of an image that is 7 inches wide by 9 inches high, the output image will be 3.5 inches wide
by 4.5 inches high.
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However, in scaling an image for the final scan, keep in mind that the values in the width and
height text boxes remain the same.

To set an image scale:
1. Select the Main tab.

2. In the Scale box, enter a new percent.

The new output size is displayed under Output Size.

Adjusting the Tone of the Preview Image
The tone of an image is its shading and combination of colors. Adjusting grayscale tones can
enhance the contrast of a grayscale image. You can produce a wide range of visual effects in your
preview image by adjusting the different settings on the Tone tab.

If you selected Black and White or Text Enhanced as the scan mode, the Tone tab is not available
for selection. In this case, you must adjust the tone of the image with the contrast/brightness
settings on the C530 (or C560) tab.
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Features of the Tone Tab

This section provides an overview of the Tone tab. Detailed instructions on using these features
are provided in later sections of this chapter.

Tone Toolbar

Tone Graph
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■ Tone Toolbar
Using the buttons on the toolbar, you can access settings which affect different aspects of
image tone, and give you great flexibility in manipulating your image tone before scanning
the image.

              

■ Tone Graph
Viewing the tone graph gives you more detail about the tone setting. The shape of the tone
graph changes to reflect the selected channel’s current tone settings.

■ Color Channel
If you choose Color as the scan mode, access to color channels is available when you use the
Contrast/Brightness, Gamma, Histogram, or Special Tone Curves tool. By selecting a color
channel, you can analyze and change specific aspects of an image’s overall color.

 Contrast/
Brightness

Gamma

Histogram

    Special
Tone CurvesAuto Tone
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Correcting the Image Tone Automatically

You can specify that tone corrections be made automatically.

To specify automatic auto tone corrections:
On the Tone tab, click the Auto Tone button.

The image in the preview area reflects your selection.
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Adjusting Contrast and Brightness

You can adjust the contrast and/or brightness of a grayscale image.

To adjust the contrast or brightness of an image:
1. On the Tone tab, click the Contrast/Brightness button.
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2. If you are working with a color image, select the appropriate color channel.

3. Move the Contrast and Brightness sliders to the left for less contrast or brightness, and to
the right for more contrast or brightness, until the desired contrast is achieved.

The image in the preview area reflects your changes.

Changing Gamma Curve Values

With the Gamma curve, you can change the mid-tones of the image to increase its contrast, and
enhance the overall image. When you increase the Gamma value, light areas are made lighter,
and dark areas are made darker.

For example, if you are scanning a photograph that has many dark tones, simply adjusting the
brightness and contrast may not improve the image as effectively as adjusting the Gamma value.
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To adjust the gamma value of an image:
1. On the Tone tab, click the Gamma button.

2. If you are working with a color image, select the appropriate color channel.

3. Move the Gamma slider to the left to decrease the mid-tone intensity, and to the right to
increase the mid-tone intensity, until the desired effect is achieved. You can also type a value
into the text box.

4. To return to the original Gamma curve setting, click Reset.
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Adjusting Histogram Tone Levels

You can use a histogram tool to adjust the tone shadow for the preview image.

Using the Black-point, Mid-point, and White-point buttons, you can sample the respective tone
in the preview image and base the image tone settings on the sampling. You can also type a
value in the Black-point, Mid-point, and White-point boxes.
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Under the histogram graph, you can slide the black, gray, and white buttons to adjust the tones.
However, you cannot edit the histogram directly.

When you adjust the black-point, all tones in the image darker than the selected black-point are
adjusted to black.

When you adjust the midpoint, all tones in the image between the black-point and the white-
point are adjusted to the selected mid-point.

When you adjust the white-point, all tones in the image lighter than the selected white-point are
adjusted to white.

When you find a combination of tone settings you like, you can save the settings in a file and
use it in future scanning sessions.

To adjust the tones using the Histogram tool:
1. On the Tone tab, select the Histogram tool button.

2. If you are working with a color image, select the appropriate color channel.

3. For the black-point, midpoint, or white-point, do one of the following to make a change:

� Click the appropriately labeled button. Then click on the portion of the image in the
preview area that is darkest (for black-point), lightest (for white-point), or in the
middle of the tonal range (for midpoint). Try zooming in on the specific part of the
image so you can be sure you are selecting the shade you want.
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� In the appropriately labeled box, enter a tone value.

� Drag the appropriate arrow at the bottom of the histogram to the level you want.

In the preview image, all tones are adjusted accordingly.

To reset to the default values:
Click Reset.

To save these settings to use on similar images:
1. Click Save.

2. In the Save As dialog box, specify the file name and location where you want to save the
setting, and click Save.

To open a previously saved tone:
1. Click Load.

2. In the Open dialog box, select the file name for the tone setting you want to load and click
Open.
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Using Tone Curves

You can use predefined tone curves to automatically correct the most common problems with
images: overexposure, underexposure, or too high or too low a contrast.

To correct an image problem with predefined tone curves:
1. On the Tone tab, click the Special Tone Curves button.

2. If you are working with a color image, select the appropriate color channel.
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3. To automatically compensate for common problems in an image, select one of the options
from the list.

To return to the system default selection:
Click Reset.

To save a setting (for example, a particular color channel and curve):
1. Click Save.

2. In the Save As dialog box, enter a file name and directory, and click Save.

The curve is saved with the file name extension .CRV.

To open a previously saved curve:
1. Click Load.

2. In the Open dialog box, select the file name for the curve setting you want to load and click
Open.

Adjusting Contrast/Brightness for Black and White Scan Mode

For black and white scans, the contrast and brightness settings are located on the C530
(or C560) tab.

Depending on the black and white option you select for your scan, you can adjust the contrast
and/or brightness of your preview image.
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If you use halftone as your scan option, you can adjust both the contrast and brightness of the
image.

If you use threshold as your scan option, since it is by definition a high contrast image mode,
you can only adjust the brightness of the preview image.
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To adjust the brightness or contrast for a black and white image:
On the C530 (or C560) tab, under Black and White Options, use the available slider to adjust
the brightness or contrast.

n
These tone adjustments are only for black and white images. If you select grayscale or color as
your scan mode, you adjust the contrast and brightness of the image only on the Tone tab.

Increasing the Speed of the Scan Process

Based on the scan option you chose on the Main tab, you can increase the speed of the scan
process. However, if you choose to do so, the image quality may not be as high.

To increase the speed of the scan process:
On the C530 (or C560) tab, under Scan Options, select the following:

■ Use Fast Color Option if you selected Color on the Main tab.

■ Use Fast Grayscale if you selected Grayscale or Text Enhance on the Main tab.
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Chapter 5
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Managing Your Documents in the Desktop Manager
Once you send a PC fax, receive a fax, or scan an image, the resulting document is available in
the Desktop Manager. You can perform a variety of tasks with your documents, as described in
this chapter.

Selecting Documents in the Desktop Manager

To work with a document, you select it in the open folder, while in either Document View or
List View. You can select one or more documents at a time for whatever task you need to
perform.

To select a document:
With the folder open, do one of the following.

■ For a single document, click the document thumbnail or document name in the list.

■ For multiple non-sequential documents, hold the Control key while clicking on each
document you want to select.
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Printing a Document in the Desktop Manager

You can print a document from any folder in the Desktop Manager.

1. In either Document View or List View, do one of the following.

� Click the document you want to print to select it. Then, click Print on the File menu.

� Drag the document to the Print button on the command bar.
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2. In the Print dialog box, specify the print options, and click OK.
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Creating a Folder

To better organize your documents in the Desktop Manager, you can create additional folders.
You create additional folders in the Cabinet. You can also create a folder within previously
created folders. When you create a folder, you assign the desired name.

To create a new folder:
1. In the Desktop Manager, select the Cabinet. If you want to store a folder within a folder,

select the applicable folder.

2. Click New Folder on the File menu.

3. In the MultiPASS Create Folder dialog box, type a name for the new folder and click OK.

If you create multiple folders or place folders within folders, you can navigate among your
folders and documents just like you do in Windows Explorer. To display the contents of a
folder, either double-click it, or click the (+) next to the folder. To collapse an open folder tree,
double-click it, or click the (–) next to the folder.
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Moving a Document

You can move a document from:

■ A system-defined folder to a user-defined folder

■ A system-defined folder or user-defined folder to the Trash folder

■ One user-defined folder to another user-defined folder.

You cannot move a document into a system-defined folder other than the Trash folder.

To move a document:
1. In either Document View or List View, open the folder containing the document you want

to move.

2. Drag the document to the desired folder.

In Document View, the document is placed in the first available grid space; in List View, it is
placed in the appropriate sort order.
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Copying a Document

A document can be copied within the same folder, or from one folder to a different folder.
When you copy a document within the same folder, the copy is assigned the same name as the
original document, with an added unique number. For example, if you copy a document called
Document, the new copy will be named Document (1).

To copy a document within the same folder:
1. Open the folder with the document you want to copy.

2. Select the document, and then click Duplicate on the Edit menu or toolbar.

To copy a document from one folder to another:
1. Open the folder with the document you want to copy.

2. While holding down the Control key, drag the document to the desired folder.

Renaming a Document or Folder

You can rename a user-defined folder or a document at any time. Folder names must be unique
within the Desktop Manager. You cannot rename a system-defined folder.

Whenever you attempt to rename a folder or document, the system verifies whether the new
name is unique. In the event of a conflict, the system alerts you of the conflict. A folder or
document name can contain blank spaces.
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To rename a document:
Do one of the following.

■ Select the document. Then click Rename on the File menu. In the Rename dialog box, type
the new name and click OK.

■ In Document View, click the document thumbnail. Then click the document name to
position the insertion point. Edit the name of the document as desired.

To rename a folder:
Do one of the following.

■ Select the folder. Then, on the File menu, click Rename. In the Rename dialog box, enter
the new name and click OK.

■ Select the folder name. Enter the new name in the highlighted rectangle.
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Deleting a Document or Folder

You can delete a document or user-defined folder when it is no longer needed.

When you delete a document or folder, it moves to the Trash folder. To permanently delete a
document or folder, you must empty the Trash folder.

To delete a document or folder:
Select the document or folder you want to delete. Then do one of the following.

■ Click Delete on the Edit menu or toolbar.

■ Press the Delete key.

When the confirmation message displays, click Yes. The document or folder is moved into the
Trash folder.

n
If the folder you are deleting contains documents, both the documents and the folder are
deleted. The deleted folder and contents are moved into the Trash folder.
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Restoring a Deleted Folder or Document

If a folder or document is in the Trash folder, you can restore it. If the location where you want
to restore the folder or document already contains an item of the same name, the item that you
are restoring from the Trash folder is assigned a new name. Folders and documents that have
been deleted from the Trash Folder cannot be restored.

To restore a deleted folder or document:
1. In the Desktop Manager, click the Trash Folder.

2. In the Trash Folder, do one of the following.

� For a folder, drag the folder to the Cabinet or to another folder within the Cabinet.

� For a document, drag the document you want to restore into the desired folder in the
Cabinet.
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Emptying the Trash Folder

Documents remain in the Trash folder until you move them to a user-defined folder, delete
them individually, or empty the Trash folder and delete all documents in the folder.

To prevent out-of-date documents from unnecessarily taking up space on your hard disk, you
should periodically review the Trash folder and remove the documents no longer needed.

To empty the Trash folder:

■ Click Empty Trash on the File menu. If prompted, confirm that you want to empty the
Trash folder.

■ Once emptied, all documents are permanently removed from the Desktop Manager
(and your hard disk).
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Importing a Document

If you have a document residing on a disk, you can import it into a user-defined folder using
the Desktop Manager. You can import a document saved in any of the following formats: TIFF,
BMP, FPX, JPG or PCX.

To import a document:
1. Open the user-defined folder into which you want to import a document.

2. Click Import on the File menu.

3. In the Import File dialog box, specify the drive, directory, and name of the file you want to
import, and click Open.
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Exporting a Document

You can export a document from the Desktop Manager, saving it to any specified drive and
directory. When you export a document, you are actually saving a copy of the original
document. Documents can be exported as a TIFF, BMP, FPX, PCX or JPEG file.

If you export a multiple page document, each page is exported as a separate document.

To export a document:
1. Open the folder with the document you want to export.

2. Select the document you want to export, and then click Export on the File menu or drag
your document to the Export button on the command bar.

3. In the Export File dialog box, specify the drive and directory where you want to place the
exported file, and click Save.
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Attaching a Document to Electronic Mail (E-mail)

If you have an e-mail application installed on your computer, that is Messaging Application
Program Interface (MAPI)-compliant (such as Microsoft Exchange), you can attach a document
in the Desktop Manager to an e-mail message. Your e-mail application must be set as the system
default MAPI client. For details, see your e-mail application documentation.

The Desktop Manager opens your e-mail application, and attaches the selected document to a
blank e-mail message. You cannot, however, open your e-mail application from the Desktop
Manager if you are not attaching a document.

When entering the e-mail address, you can select an address from any personal address book
you set up in your e-mail application. You cannot use an e-mail address from the Desktop
Manager Address Book, if you had set up your e-mail application for faxing with the MultiPASS
system (as described in Chapter 3, PC Faxing).

To attach a document to an e-mail message:
1. Do one of the following.

� In the Desktop Manager, drag the document to the Send Email button on the
command bar.

� Select the document you want to attach. Then click Send Email on the File menu.

2. In your e-mail application window, enter the e-mail address and complete the message as
you normally would. Then, click the command to send the message with the attached
document.



Chapter 5 Working With Documents    5-16

Manipulating a Document in Document View

If you are working in Document View with documents in any folder, you can manipulate your
documents in a variety of ways. For example, you can arrange documents within a single folder
in a preferred order, remove a page from a document, split a multi-page document, or merge
one document with another.

Arranging Documents in Document View

A document thumbnail in Document View retains its position until you rearrange it. You can
arrange one or more documents manually or automatically.

When you arrange documents automatically, they are positioned within a grid, with row
positions filling from left to right.

To arrange documents manually:
With the desired folder open, select the document you want to move and drag it to the desired
location within the work area.

To arrange documents automatically:
With the desired folder open, click Arrange on the View menu or toolbar.
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Scrolling Through a Multi-Page Document

You can scroll through a multiple-page document to position yourself at the page you want to
remove or where you want to split the document.

As you scroll through pages in the document, the current page number updates instantly. After
scrolling, the top page is retained even if the folder is closed and reopened.

To scroll through pages in a document:
For the selected document, do one of the following.

■ Click the left and right scroll arrows displayed with the page numbers for the document.

■ Drag the scroll tab on the right side of the document.

 

Scroll  Tab
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Removing a Page from a Document

You can remove the current top page of a document. For example, you may want to remove the
cover page from a received fax.

1. Scroll through the document until the page you want to remove is on top.

2. Click Remove Page on the Edit menu or toolbar.

Splitting a Document

You can split a document into two documents from any page after the first page. In other words,
you cannot split a document on page 1. For example, you split a 10-page document, beginning
at page 5. The original document consists of pages 1 through 4. The newly created document
consists of pages 5 through 10.

The original document — consisting of at least the first page, up to the page where the split
occurred — retains the original name. The newly created document is assigned a new unique
name, which can be changed as desired.

To split a document:
1. Scroll through to the page where you want to split the document. The top page represents

the first page for the newly created document.
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2. Click Split on the Edit menu or toolbar.

Merging a Document

You can merge two documents to combine them into a single document. The documents are
merged in the order you select them. In other words, the first document selected becomes the
top pages of the second document selected. Both documents are merged into the second
document.

To merge two or more documents:
Do one of the following.

■ Drag a document on top of another document. The document that you dragged is merged
with the document that you dropped it into.

■ Select two or more documents that you want to merge (hold down the Control key while
selecting the documents). Then click Merge on the Edit menu or toolbar.
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Indexing and Searching for Documents

The Desktop Manager stores key information about each document it receives in an internal
document management database. This database enables you to locate documents based on
certain search criteria.

The Desktop Manager enables you to search for documents:

■ Automatically by date and time.

■ By document text and the text contained within the document if you enabled the
Automatic Indexing option in the System Setup dialog box. (For details, refer to the
“Setting Up System Options” section of Chapter 6, Utilities.)

■ By creator, owner, or keyword for a document, if you first define the criteria and assign it to
the desired documents.

Based on the search criteria you want to use, follow these general guidelines for searching your
documents.

If you want to search documents by date and time, and text:
Simply run the document search, specifying the search criteria. You do not need to define a
search index for your documents first. For details about running the search, see the “Searching
Your Documents” section later in this chapter.
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If you want to search documents by creator, owner, or keyword:
1. In the Desktop Manager, set up the search index by defining the document creator, owner,

and/or keyword. For details, see the “Setting Up the Search Index” below.

2. Assign the index criteria to your documents. For details, see the “Setting Up the Search
Index” below.

3. Run the search for documents based on the desired criteria. For details about running the
search, see the “Searching Your Documents” section later in this chapter.

Setting Up the Search Index

If you want to search your documents by a creator, owner, or keyword, you must first create a
search index.

Setting Up a Creator to the Index

You can set up creators in your search index that correspond to the persons or companies that
send you documents in the Desktop Manager, such as faxes. After assigning the appropriate
creator to each document, you can then search your documents for those from the specified
creator.
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To set up a document creator to the index:
1. In the Desktop Manager, point to Index By on the Tools menu, and then click Creators.

2. In the Edit Creator List dialog box, click Insert.

3. Type the creator name you want to add to the index and press Enter.

4. Repeat steps 2 and 3 for each creator you want to add.

5. Click Close to close the Edit Creator List dialog box and save your index entries.
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To change a creator:
In the Edit Creator List dialog box, select the creator you want to change and click Change. Edit
the creator as desired and press Enter.

To remove a creator:
In the Edit Creator List dialog box, select the creator you want to remove and then click
Remove. When the confirmation message appears, click Yes.

Setting Up an Owner to the Index

You can set up owners in your search index that correspond to the people in your office that
receive documents in the Desktop Manager, such as faxes. After assigning the appropriate owner
to each document, you can then search your documents for those belonging to the specified
owner.
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To set up a document owner to the index:
1. In the Desktop Manager, point to Index By on the Tools menu, and then click Owners.

2. In the Edit Owner List dialog box, click Insert.

3. Type the name of the owner and then press Enter.

4. Repeat steps 2 and 3 for each owner you want to add.

5. Click Close to close the Edit Owner List dialog box and save your index entries.
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To change an owner:
In the Edit Owner List dialog box, select the owner you want to change and click Change. Edit
the owner as desired and press Enter.

To remove an owner:
In the Edit Owner List dialog box, select the owner you want to remove and then click Remove.
When the confirmation message appears, click Yes.

Setting Up Keywords to the Index

You can set up keywords in your search index that correspond to important ideas or subjects in
the documents you receive in the Desktop Manager, such as faxes.

For example, you may want to set up keywords for special projects you are negotiating. After
assigning the appropriate keywords to each document, you can search your documents for
those containing the specified keywords.
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To set up a document keyword to the index:
1. In the Desktop Manager, point to Index By on the Tools menu, and click Keywords. Or

click Edit Keywords on the toolbar.

2. In the Edit Keyword List dialog box, click Insert.

3. Type the keyword you want to add and then press Enter.

4. Repeat steps 2 and 3 for each keyword you want to add.

5. Click Close to save your entries and close the dialog box.
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To change a keyword:
In the Edit Keyword List dialog box, select the keyword you want to change and click Change.
Edit the keyword as desired and then press Enter.

To remove a keyword:
In the Edit Keyword List dialog box, select the keyword you want to remove, and then click
Remove. When the confirmation message appears, click Yes.

Assigning Index Criteria to Documents

After adding keywords, creators, and owners to the index, you need to assign them to your
documents.
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To assign index criteria to a document:
1. In the Desktop Manager, select the document to which you want to assign index criteria.

2.  Click Manual Index on the Tools menu or toolbar.

3. In the Manual Indexing dialog box, assign the creator, owner, or keyword to your document
based on the instructions in the following sections.

4. Click Submit to save your index assignments.

Click Cancel to close the dialog box without saving your index assignments.
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To assign a creator index entry:
1. In the Manual Indexing dialog box, click Creator.

2. In the Select Creator dialog box, select the creator you want to assign to the document.

To edit the Creator list, click Edit List. For procedures, see the “Setting Up a Creator to the
Index” section in this chapter.

3. After assigning a creator, click OK.
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To assign an owner index entry:
1. In the Manual Indexing dialog box, click Owner.

2. In the Select Owner dialog box, select the owner you want to assign to the document.

To edit the Owner list, click Edit List. For procedures, see the “Setting Up an Owner to the
Index” section in this chapter.

3. After assigning an owner, click OK.
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To assign a keyword index entry:
1. In the Manual Indexing dialog box, click Keywords.

2. In the Select Keyword dialog box, select a keyword in the list on the left that you want to
assign to the document, and then click Add.

3. Repeat step 2 for each keyword you want to assign.

To remove a keyword, select it in the list on the right and click Remove.

To remove all keywords, click Clear.

To edit the keyword list, click Edit List. For procedures, see the “Setting Up Keywords to
the Index” section in this chapter.

4. After assigning the keywords, click OK.
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Displaying the Document

If you want to view the document, you can do so while assigning the search criteria. Viewing at
this point enables you to check whether you are assigning the search criteria to the right
document.

To view the document:
In the Manual Indexing dialog box, click Display Document.

The document appears in the MultiPASS Viewer. For details, see the “Modifying a Document”
section later in this chapter.

To return to the Manual Indexing dialog box:
In the MultiPASS Viewer, click Exit on the File menu.
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Searching Your Documents

You can search for a document by date and time, and the text within a document. If you created
the appropriate search index and assigned the search criteria to your document, you can search
by creator, owner, and keyword.

When you run the search, you determine which documents you want to search:

■ All the documents in the Desktop Manager

■ Only the documents found from a previous search

■ Only the documents you select before you begin the search.

The search is performed on all the folders in the Desktop Manager (system- as well as user-
defined folders).

The following procedures summarize how to search for documents in the Desktop Manager.

To search for a document:
1. In the Desktop Manager, if you want to search only specific documents, select the

documents in the desired folder.

Otherwise, proceed to step 2.
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2. Click Search on the Tools menu or toolbar.

3. In the Search dialog box, specify your search criteria.

Select the Search On criteria (the documents on which you want to search). If you intend
to search only selected documents, you must select the appropriate documents before you
begin the search. See step 1.

4. Click Search if you are satisfied with the criteria you specified and want to begin your
search.

Click Reset to clear the dialog box of any previously entered criteria and reenter criteria.
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5. In the Search Result dialog box, review the result of the search.

Any documents which match the specified search criteria are included in the result list.

Specifying Search Criteria

To search for a document, you must specify the criteria by which you want the Desktop
Manager to use to locate a document.

To search documents by date and time:
In the Search dialog box, in the From and To boxes, enter the desired dates and time.

To search documents by creator:
1. In the Search dialog box, click Creator.

2. In the Select Creator dialog box, select the Creator by which you want to search, and then
click Add.

� To remove a selected creator, select it in the assigned list and click Remove.

� To remove all selected creators, click Clear.

� To change the list of creators, click the Edit List. For details, see the “Setting Up a
Creator to the Index” section in this chapter.

3. After completing your selections, click OK.
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To search documents by owner:
1. In the Search dialog box, click Owner.

2. In the Select Owner dialog box, select the Owners by which you want to search, and then
click Add.

� To remove a selected owner, select it in the assigned list and click Remove.

� To remove all selected owners, click Clear.

� To change the list of owners, click the Edit List. For details, see the “Setting Up an
Owner to the Index” section in this chapter.

3. After completing your selections, click OK.

To search documents by keyword:
1. In the Search dialog box, click Keywords.

2. In the Select Keyword dialog box, select each Keyword by which you want to search, and
then click Add.

� To remove a selected keyword, select it in the assigned list and click Remove.

� To remove all selected keywords, click Clear.

� To change the list of keywords, click Edit List. For details, see the “Setting Up
Keywords to the Index” section in this chapter.

3. After completing your selections, click OK.



Chapter 5 Working With Documents    5-37

To search documents by text string:
1. In the Search dialog box, in the Text box, type the text by which you want to search.

2. Select the type of text match you prefer:

� Any
Look for the specified text in any part of a word

� Exact
Look for exact text matches only

� Start of Word
Look for the specified text in the start of a word only.

3. Select where within the document the Desktop Manager should search for a text match:

� Text
Search on text within the body of a document

� Annotation
Search on annotations you may have added to the documents in the Desktop Manager.
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Specifying Which Documents to Search

You can specify to search on the following documents:

■ Full
Search all your documents within the Desktop Manager

■ Last Result
Search only the results of the last search you made

■ Selected Items
Search only those documents that are selected before you begin the search.

Reviewing the Results of Your Search

The results of your search appear as a list of documents that match the search criteria.

This list displays the document name and the folder in which the document can be found. The
list also shows how closely the document matches the criteria (the match level or hit rate),
expressed as a percentage.
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To display a document:
Do one of the following.

■ Select the document in the list, and click Display.

■ Double-click the document name.

To run a new search:
Click Search.

To close the Search Result dialog box:
Click Close.
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Redisplaying the Result of Your Last Search

The Desktop Manager saves the result of your last search. When necessary, you can redisplay the
result.

To redisplay the result of the last search:
Click Show Results on the Tools menu or toolbar.

Modifying a Document
You can open a document to view its contents, and then annotate it with notes, highlighting,
stamps, sticky notes, or graphics (line/arrow, rectangle, circle). Although you can save the
document with the annotations, they are only added markings placed on the original
document, not an integral part. The original content of the document remains intact. If you
select to fax or print the modified document, you have the option not to include the
annotations with the document.
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When you open a document for annotation, the document appears in the MultiPASS Viewer.

The following instructions summarize the procedures for annotating a document. For
additional information, refer to later sections in this chapter.

      Sticky-Note

                 Highlight

Stamp

      Drawn Graphic
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To open a document in the MultiPASS Viewer:
In the Desktop Manager, do one of the following.

■ Double-click the document.

■ Select the document you want to open, and then click Open Document on the File menu.

■ Drag the document to the Open Document button on the command bar.

To annotate a document:
1. With the document open in the MultiPASS Viewer, adjust the size of your view of the

document as needed.

2. Insert the desired annotations.

3. Click Save on the File menu to save the annotations with your document in the Desktop
Manager.

To close the MultiPASS Viewer:
Click Exit on the File menu. If you neglected to save your annotations, you are prompted to do
so before the program closes.
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Features of the MultiPASS Viewer Window

This section provides an overview on the basics of working with the MultiPASS Viewer window.
Detailed instructions for using the various commands and components of the screen are
provided in later sections of this chapter.

  

Annotation  Toolbox

Menu Bar

Image Palette

Document
Display Area

Status Bar

File Toolbar

Image Toolbar
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■ Menu Bar
The menu bar contains commands that enable you to perform various tasks with your
document. Some of the commands can also be accessed by their corresponding buttons on
the toolbar.

Some of the menu commands are also available on shortcut menus, which are displayed by
clicking the right mouse button in the MultiPASS Viewer window.

■ File Toolbar
The File toolbar provides you quick access to commands needed to open, save, copy, print,
and zoom a document.

■ Image Palette
The Image palette provides you quick access to commands needed to select, move, zoom, or
annotate a document.

          

Previous Page

Help
Topics

Zoom

Redo

Undo

Crop
Inplace

Copy

Print

Save

Open Next Page

Annotations

Straighten

Zoom

Move

Lasso

Select



Chapter 5 Working With Documents    5-45

■ Image Toolbar
The Image toolbar provides quick access to commands needed to make various
adjustments to an image.

      

■ Annotation Toolbox
The Annotation toolbox enables you to add text and graphics to your document.
Annotations are integral elements of the document. Unless you select to “hide them,”
they are sent with the document, and can be printed, edited, and saved.

          

■ Document Display Area
The document itself is displayed and modified in the Document Display Area. You can page
or scroll through the document, enlarge or reduce the view of the document, or change the
orientation. The display area also contains the results of any annotations you may make.

Brightness & Contrast

Color BalanceAuto Level

Auto Color

Selection Arrow TextLine

Rectangle Ellipse Polygon

Free Drawing

Highlighter Stamp

Sticky Note
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■ Status Bar
The status bar appears at the bottom of the window. It contains useful information about
the document that you are currently viewing.

Adjusting the Document Image

With different tools in the MultiPASS Viewer, you can adjust the size and image type of your
document and the manner in which it appears.

Adjusting the Size of a Document

Adjusting the size of a document can be useful in planning other tasks. For example, if a
document consists solely of a large graphic, you may want to reduce its size so that it can be
used later in creating a background for a cover page.

Changing the size of a document involves changing the number of pixels used to represent it.
Such a change permanently alters the document file.
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To adjust the size of a document:
1. Click Image Size on the Adjust menu.

2. In the Image Size dialog box, enter the dimensions of the newly sized document.

3. Click OK. The document file is resized.
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Adjusting the Image Type

You can adjust the type of image for the document display.

To adjust the image type:
1. Point to Image Type on the Adjust menu.

2. Select one of the following image types:

� True Color
True Color images contain 8 bits per pixel for red, green, and blue channels. Each pixel
contains 24 bits.

� Grayscale
Grayscale images contain 8 bits per pixel.

� Black and White
Select one of the following.

Binary: Images are one bit per pixel.

Half Tone: Simulates the tonal range of an image with a precise pattern of lines and
dots.

Text Enhanced: Images are grayscale images (8 bits per pixel) converted to binary
images (1 bit per pixel) using Canon ImageTrust technology.
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Adjusting Your View of a Document

In annotating a document, you may need to adjust your view of it. Among the ways you can
adjust the view of an open document is hiding or showing the different components of the
MultiPASS Viewer.

To show/hide the components of the window:
1. On the View menu, point to Toolbars. The options displayed with check marks beside them

are currently displayed in the MultiPASS Viewer.

2. Click the option that you want to show (check mark displays) or hide (no check mark
displays).

Adjusting the Orientation of the Document Display

When creating or editing a document, you may want to adjust your view of the document
display. You can rotate the base page clockwise by selected increments. You can also flip the
document display vertically (flipping the document elements from top to bottom or vice versa)
or horizontally (flipping the document from left and right).

To rotate the document:
On the Edit menu, point to Rotate, and then select 90, 180 (flipping the document upside
down), or 270.

To flip the document display:
On the Edit menu, point to Flip. Then click Horizontal or Vertical.
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Straightening a Document Display

You may need to straighten the document base image before you begin adding text or graphics
to it. For example, you may have received a fax that was not perfectly straight.

To straighten a document:
1. On the Image palette, click the Straighten button.

  

2. On the Straighten toolbar, click the Rotate Clockwise or Rotate Counter Clockwise button
to rotate the crosshairs until it aligns with the document image.

3. Click the Straighten button to have the system adjust the document image to its properly
aligned position.

Rotate
Clockwise

Rotate Counter
Clockwise

Straighten
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Adjusting the Display Size

The MultiPASS Viewer provides you with different levels of magnification allowing you to work
at the most comfortable size. You can zoom in and out at predefined increments, or specify a
particular size or scale. You can also adjust the document image size so that the entire document
is visible within the window.

To zoom in or zoom out on the document:
Do one of the following.

■ On the View menu, point to Zoom, and then select the desired level of magnification.

■ On the File toolbar, select the desired level of magnification in the list.

■ On the Image palette, select the Zoom tool, and then:

� To increase magnification, select the document.

� To decrease magnification, hold down the Alt key, and select the document.

To fit the document to the display window:
Click Fit Image to Window on the View menu.
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Scrolling Through a Zoomed Document

If you need to work on particular aspects of a document (for example, modifying a recurring
graphic), you can scroll through the document while maintaining a high level of magnification.

To scroll through a zoomed document:
1. On the View menu, click Show Navigator. The Navigator window opens in the right corner

of the screen. Inside the Navigator, a white rectangle indicates the area of your document
that is currently in view.

2. On the Image palette, click Move.

3. While tracking your position in the Navigator window, drag the image to bring the desired
area of the document into view.
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Selecting an Area of a Document

When editing the base image of a document, you may need to select the specific area that you
want to edit.

To select an area of a document:
1. On the Image palette:

� Select the Select tool for areas that fit easily inside a square or rectangle.

� Select the Lasso tool for irregularly shaped areas.

2. Drag the cursor to draw the appropriately shaped outline for the area you want to select.

Cropping a Document

You can crop a document to any size that you select.

To crop a document:
1. Select the area of the document to which you want the entire page to conform.

2. Click Crop Inplace on the Edit menu or toolbar.
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Making Image Adjustments

Adjustment features allow you to make adjustments to the image including contrast, brightness,
sharpness, and cleanup. You can produce a wide range of visual changes in your image.

Image adjustment options are only available when you select True Color or Grayscale as your
image type.

Adjusting Color and Color Level Automatically

You can have the system automatically adjust the color and color level by using the Auto Level
and Auto Color options. These options adjust the image color and color level for best viewing
with your computer monitor or other output device.

To adjust the color level automatically:
Click Auto Level on the Adjust menu to adjust the color level of your image.

To adjust the color automatically:
Click Auto Color on the Adjust menu to adjust the color of your image.
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Adjusting Brightness and Contrast

You can adjust the brightness and contrast of a color or grayscale image.

To adjust the brightness and contrast:
1. Select the image or a portion of the image.

2. Click Brightness and Contrast on the Adjust menu or toolbar.

In the Brightness and Contrast dialog box, the original image appears on the left of the
dialog box. As you modify the image, you can see the results in the image on the right.
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3. Move the Brightness slider to the left to make the image darker, to the right to make the
image brighter.

4. Move the Contrast slider to the left to decrease contrast, to the right to increase contrast.

5. When the current image appears as you want it, click OK to accept the changes. Click
Cancel.

Adjusting the Color Balance

You can adjust the color components of an image by changing the level of red, green, and blue
colors that make up the shades in your image.

To adjust the color balance:
1. Select the image or a portion of the image.

2. Click Color Balance on the Adjust menu or toolbar.
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3. In the Color Balance dialog box, move the Red, Green, and Blue sliders to the left for less
color, to the right for more color.

As you modify the image, you can see the results in the image on the right.

4. When the current image appears as you want it, click OK to accept the changes. Click
Cancel to abandon the changes.
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Setting the Black Point and White Point

If you are not satisfied with the results of the Auto Level or Brightness & Contrast features, you
may want to first manually define the contrast range of the image by setting the image highlight
and shadow points, or the black point and white point. With this method, you specify what you
consider to be the important highlight and shadow details. You can select the darkest point and
the lightest point to more effectively adjust the image contrast with Auto Level or the Brightness
& Contrast features. When adjusting the image level, these points define the lightest and darkest
points of the range when you adjust the image contrast.

To set the black point and white point:
1. Select the image or an image portion.

2. On the Adjust menu, click Black Point/White Point.

3. In the Black Point/White Point dialog box, click Black Point.
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4. Move the pointer over the Original thumbnail. As you move the pointer over the image,
the black value, expressed as a percentage of the current pixel, appears to the left of the
Black Point button.

5. Move the pointer over the image until you find the blackest point. This point will have the
value closest to 0%. Select the pixel.

6. Click White Point.

7. Move the pointer over the Original thumbnail. As you move the pointer over the image, the
white value, expressed as a percentage of the current pixel, appears to the left of the White
Point button.

8. Move the pointer over the image until you find the whitest point. This is the point with the
value closest to 100%. Select the pixel.

9. Click OK.
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Blurring an Image

You can blur the image to soften the edges and fields of a grainy color or grayscale image. Blur
averages the color values of adjacent pixels, removing peaks, to make the image smoother.

1. Select the image or an image portion.

2. On the Adjust menu, click Blur.

3. In the Blur dialog box, move the Blur slider to the left for less blur, to the right for more
blur.

As you move the slider, the adjustments appear in the Current thumbnail.

4. Click OK to accept the changes. Click Cancel to abandon the changes.
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Sharpening an Image

You can sharpen an image to increase the difference between color values of adjacent pixels,
sharpening the appearance of a color or grayscale image.

1. Select the image or an image portion.

2. On the Adjust menu, click Sharpen.

3. In the Sharpen dialog box, move the Sharpen slider to the left to sharpen less, to the right to
sharpen more.

As you move the slider, the adjustments appear in the Current thumbnail.

4. Click OK to accept the changes. Click Cancel to abandon the changes.
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Removing Noise

You can remove noise or distortions from the image. The Remove Noise filter averages the color
values of adjacent pixels.

1. On the Adjust menu, point to Advanced, and then click Remove Noise.

2. Drag the Removal slider to the left to remove less noise, to the right to remove more noise.

As you drag the Removal slider, your changes appear in the Current thumbnail. You can
compare the changes to the Original thumbnail.

3. Click OK to accept your changes. Click Cancel to leave the image unchanged.
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Removing Moire Patterns

You can remove moire patterns from an image. Because moire patterns are caused by the
intersection of lines in two directions, removing the pattern requires the following procedure to
be performed twice, resetting the angle option for each set of intersecting lines.

To remove moire patterns:
1. Select the image area where the pattern occurs.

2. On the Adjust menu, point to Advanced, and then click Remove Moire.
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3. In the Angle box, enter the angle of the moire lines to be removed.

4. Drag the Remove Moire slider to the left to remove less, to the right to remove more.

As you make changes to the image, your changes appear in the current thumbnail. You can
compare the changes to the Original thumbnail.

To better see your changes, you can use the zoom buttons to magnify the thumbnails.

5. Click OK to accept your changes. Click Cancel to leave the image unchanged.

Removing JPEG Artifacts

JPEG images that have been compressed using maximum compression may display scattered
noise, called JPEG artifacts, around the image edges. You can remove these distortions.

1. Select the area of the image where the artifacts occur.

2. On the Adjust menu, point to Advanced, and then click Remove JPEG Artifacts.



Chapter 5 Working With Documents    5-65

3. In the Remove JPEG Artifacts dialog box, drag the Removal slider to the left to remove less,
to the right to remove more.

As you make changes to the image, your changes appear in the current thumbnail. You can
compare the changes to the Original thumbnail.

To better see your changes, you can use the zoom buttons to magnify the thumbnails.

4. Click OK to accept your changes. Click Cancel to leave the image unchanged.
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Removing Show-Through

Image show-through is caused by patterns from the reverse side of a page showing through the
original image. You can remove image show-through while preserving the image.

1. Select the image portion you want to adjust.

2. On the Adjust menu, point to Advanced, and then click Remove Show-Through.
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3. In the Remove Show-Through dialog box, use the Range slider to adjust Removal slider
sensitivity according to the contrast of the pixels showing through to the background.

If there is a wide range between color, move the Range slider to the right. If there is little
range between the pixels showing through and the background, move the slider to the left.

4. Drag the Removal slider to the left to remove less show-through, to the right to remove
more show-through.

5. Click OK to accept your changes. Click Cancel to leave the image unchanged.

Removing Dust

Even if you have carefully cleaned the original image, there may be some dust on the image.
Dust leaves small spots on your image, usually one or two pixels in size. You can easily remove
dust or any small speckles from an image, blending the color of the dots with the adjacent
pixels. You can control the degree of blending.

1. Select the area of the image where the dust appears.

2. On the Adjust menu, point to Advanced, and then click Remove Dust.
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3. In the Remove Dust dialog box, click Dark and/or Light, depending on the color of the
dust.

4. Drag the Threshold slider according to the deviation of the dust from dark to light.

5. Drag the Removal slider to the left to remove less dust or to the right to remove more dust.

Moving the slider to the right blends the dust more with the background color that
surrounds the dust. As you drag the Removal slider, your changes appear in the Current
thumbnail. You can compare the changes to the Original thumbnail.

You can also use the zoom buttons to magnify the thumbnails.

6. Click OK to accept your changes. Click Cancel to leave the image unchanged.
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Removing Scanner Noise

You can remove distortions associated with scanned images, such as color bands and streaks.

1. Select the area of the image where the scanner noise appears.

2. On the Adjust menu, point to Advanced, and then click Remove Scanner Noise.

3. In the Remove Scanner Noise dialog box, select Vertical or Horizontal according to the
direction of the streaks or bands.
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4. Drag the slider to the left to remove less noise, to the right to remove more noise.

As you drag the slider, your changes appear in the Current thumbnail. You can compare the
changes to the Original thumbnail.

You can also use the zoom buttons to magnify the thumbnails.

5. Click OK to accept your changes. Click Cancel to leave the image unchanged.

Adding Annotations to Your Document

The following sections describe the various ways you can annotate your document. For a
sample of annotations you can add to your document, refer to the “Modifying a Document”
section, presented earlier in this chapter.

Adding Text to a Document

You can add text on any portion of your document. When you do so, you can select the text
attributes: font, font size and color, and special effects (underline, strikeout), background color
and mode.

You can type any text that you want, editing it later as necessary. If you select a font, font size, a
color, or special effect, it affects the entire note. If you change any of the attributes while editing
a note, or while the note is selected, it changes all the text in the note.
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To add text to the document:
1. Click the Annotations button on the Image palette.

2. On the Annotations toolbar, click the Text button and drag the cursor to draw an
appropriately sized square or rectangle in the document display area.

3. Enter the new text.

To edit text added to a document:
1. On the Annotation Toolbar, with the Selection tool selected, double-click the text you

added. The cursor changes to an insertion point.

2. Edit the text as needed.

3. Click anywhere outside the text to save your changes.

To change the font and color:
1. Select the text.

2. To set font properties for the text, on the Annotations menu, click Select Font. In the Font
dialog box, select the font attributes and click OK.

3. To set a background color for the text, on the Annotations menu, click Background Color.
Select the desired color on the displayed menu and click OK.

4. To set the text color, on the Annotations menu, point to Foreground Color. Then select the
desired color.
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Setting Font Defaults

In adding annotations to your document, you can use a number of different text tools. Each
tool includes options for adjusting font style, size, and effects. Additionally, you can also select a
set of font properties to be used as defaults whenever font properties are not customized for a
particular tool.

To set font defaults:
1. Click Select Font on the Annotation menu.

2. In the Font dialog box, select your preferred options. Then click OK.
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Adding a Sticky-Note

Rather than add text directly to a document, as you do with the Text tool, you can add a sticky-
note to any portion of the document.

When you add a sticky-note, you can select the text attributes: font, font size and color,
background color, and special effects (underline, strikeout).

You can type any text that you want for the sticky-note, editing the note later if necessary. If you
select a font, font size, a color, or special effect, it affects the entire note. If you change any of the
attributes while editing a note, or while the note is selected, it changes all the text in the note.

To add a sticky-note:
1. On the Annotations toolbox, select the Sticky-Note tool and drag the cursor to draw an

appropriately sized square or rectangle.

2. Type the text of your note.

To edit sticky-note text:
1. On the Annotation Toolbar, with the Selection tool selected, double-click the sticky-note.

The cursor changes to an insertion point.

2. Edit the text as needed.

3. Click anywhere outside the sticky-note to save your changes.
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To change the font and color:
1. Select the sticky-note.

2. To set font properties for the text, on the Annotations menu, click Select Font. In the Font
dialog box, select the font attributes and click OK.

3. To set a background color for the sticky-note, on the Annotations menu, point to
Background Color. Then click the desired color on the displayed menu.

Inserting a Stamp

You can insert either a text or graphic image stamp on your document. The Desktop Manager
contains a library of available stamp images, stored as BMP files, that were installed with the
Desktop Manager software.  Additionally, you can add graphics into the stamp library if the
graphic is saved in a BMP format.

To add a new stamp to the library:
1. Click Select Stamp on the Annotation menu.
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2. In the Image Stamp tab of the Select Stamp dialog box, click Add.

3. In the Open dialog box, locate the BMP file you want to add to the Stamp library and click
Open.

4. If you have multiple graphics you want to add, repeat step 3.
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To insert a stamp on the document:
1. In the Image Stamp tab of the Select Stamp dialog box, click the graphic you want to insert

into the document and click OK.

2. In the MultiPASS Viewer, click the Stamp tool on the Annotation toolbox.

3. Click the mouse at the location where you want to place the graphic in the document
display area.

Creating a Text Stamp

You can also create and use a text stamp.

To create a text stamp:
1. Click Select Stamp on the Annotation menu.

2. In the Select Stamp dialog box, select the Text Stamp tab.

3. On the Text Stamp tab, click Add.
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4. In the Text Stamp Edit dialog box, type the text you want to assign to the Stamp in the
upper box.

� To add a date to the stamp, click Date. A code representing the date appears in the
upper box and the date is viewable in the lower preview box.

� To add the current time to the stamp, click Time. A code representing the time appears
in the upper box and the time is viewable in the lower preview box.

� To change the font and text characteristics of the text, click Font.

In the Font dialog box, specify your desired font type, style, size, and effects. Then click
OK.

5. Click OK in the Text Stamp Edit dialog box to close the dialog box.

6. Click OK again in the Select Stamp dialog box to close the dialog box and save the text
stamp.
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To insert a text stamp:
1. Click Select Stamp on the Annotation menu.

2. In the Select Stamp dialog box, select the Text Stamp tab.

3. On the Text Stamp tab, select the text stamp you want to insert into the document and click
OK.

4. In the MultiPASS Viewer window, on the Annotations menu, point to Tools and then click
Stamp. Or click Stamp in the Annotation toolbox.

5. Click the mouse at the location where you want to place the text stamp in the layout area.

To edit a text stamp:
1. Click Select Stamp on the Annotation menu.

2. In the Select Stamp dialog box, select the Text Stamp tab.

3. On the Text Stamp tab, select the stamp you want to edit, and then click Edit.

4. In the Text Stamp Edit dialog box, modify the text and click OK.

5. In the Select Stamp dialog box, click OK to save your changes and close the dialog box.
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To remove an image or text stamp:
1. Click Select Stamp on the Annotation menu.

2. In the Select Stamp dialog box, select the appropriate tab to remove either the graphic or
text, and then click Delete.

3. When the confirmation message displays, click Yes.

4. In the Select Stamp dialog box, click OK to save your changes and close the dialog box.

Highlighting Your Document

You can add a color highlight to text or other images in a document. To do this, select a color
and then draw a rectangular highlight over the desired area. All highlight colors are transparent
and display in the color you specify. When you print the document, the highlighted region
prints as gray shadings.

To highlight a region:
1. On the Annotations toolbox, select the Highlighter tool.

2. To select a highlighting background color, point to Background Color on the Annotation
menu, and then click the desired color.

3. Drag the cursor over the area you want to highlight. When you release the mouse button,
the highlight is completed.
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Creating a Drawing Graphic

You can also annotate a document with one or more drawing objects that include a straight line,
a single-headed arrow, a hollow rectangle, and a hollow circle or ellipse. When you draw the
object, you can select the color, line thickness, and style of line for the object.

To create a drawing object:
1. On the Annotation toolbox, select the drawing object tool.

2. On the Annotation menu, select the color, line thickness, and style of line for the object you
are drawing. For an arrow or line, also select the particular style you want to use.

3. At the desired location in the document display area, drag the cursor to draw the object.
When you release the mouse button, the object is completed.
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Revising Your Annotations

Once you have added annotations to your document, you can revise them as needed. For
example, you may want to resize, move, or delete an annotation.

Selecting One or More Annotations

To revise an annotation, you must first select it. You can select one or more annotations at a
time.

To select a single annotation:
Click the Select Annotations button on the Annotations toolbar. Then select the annotation.

To select multiple annotations:
With the Select Annotations button selected, hold down the Shift key and select each
annotation. You cannot resize an annotation using this method.

Moving an Annotation

You can move an annotation from one position to another.

To move an annotation:
Select the annotation and drag it to the desired location.
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Resizing the Annotation

When you create an annotation, you draw it to the desired size. If the original size proves
unsuitable, you can resize the annotation.

To adjust the size, click the border of the annotation and drag any sizing handle.

Aligning Annotations

When placing annotations in the layout area, you may be concerned that they properly align, to
make them more visually appealing. You can align two or more selected annotations, based on
the position of the first field you select. The first annotation selected in the set of fields to be
aligned is the anchor for the alignment.

You can align annotations, based on the first selected annotation, by their top, bottom, left, or
right border.

You can also center the annotations horizontally with one another, in a row, or vertically with
one another in a column.

To align annotations:
1. Select the two or more annotations you want to align.

2. Point to Align on the Annotation menu. Then select the desired alignment.



Chapter 5 Working With Documents    5-83

Copying a Field or an Annotation

You can copy a field or graphic item and paste it into another Windows application which
supports a Paste option. When you copy a field or graphic item, it is placed in the clipboard.

To copy a field or graphic element:
With the element to be copied selected, click Copy on the Edit menu or toolbar.

Removing an Annotation

If you decide you no longer want an annotation to appear in your document, you can remove it
permanently by selecting it, and then pressing the Delete key.

Reverting to the Last Saved Version

If you are dissatisfied with changes that you have made to your document, you can discard them
and return to the last saved version.

To revert to the last saved version:
Click Revert to Original on the File menu.



Chapter 5 Working With Documents    5-84

Printing the Document

You can print a copy of the document currently open in the MultiPASS Viewer, with or without
any annotations you may have created. Prior to printing, you can specify certain print setup
options.

To define the print setup:
1. On the File menu, click Print Setup.

2. In the Print Setup dialog, specify your print options and click OK.
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To print the document:
1. Click Print on the File menu or toolbar.

2. In the Print dialog box, specify the desired print options and click OK.
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To preview the document before printing:
1. Click Print Preview on the File menu.

2. From the Print Preview window, you can:

� Click Print to print the document.

� Click Next Page or Prev Page to view other document pages.

� Click Two Pages to view two pages at a time.

� Click Zoom In or Zoom Out to better view the document.

� Click Close to close the window without printing.
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Adjusting the MultiPASS Viewer Default Options

As you work in the MultiPASS Viewer, you can change options that affect the view and scale of
the open document.

To adjust default options:
1. Click Preferences on the File menu.

2. In the Preferences dialog box, set the following options:

� Set the unit of measurement to Pixels, Inches, or Centimeters from the list.

� Click the Automatically Fit Window to Image option to automatically resize the
window to your image when you make any change.

� Click High Quality When Zooming to maintain a high display quality when your
document or cover page is magnified.

3. Click OK to save your changes and close the Preferences dialog box.
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Setting Up Fax Options in the Desktop Manager
The Desktop Manager contains setup options that define the operation of faxing with your
MultiPASS. Although you can set MultiPASS fax options directly in the device itself, you can
also set the options in the Desktop Manager. You can set options that affect general operation
preferences, sending a PC fax, receiving a fax, and using the speed dial.

When you first install the Desktop Manager, setup options are set to appropriate default
settings. The default settings enable you to begin using your MultiPASS with the Desktop
Manager immediately. However, you can change option settings as needed.

Because you can make changes to most option settings either on the MultiPASS or in the
Desktop Manager, be aware of the following:

■ Any option setting you make on the MultiPASS does not appear in the Desktop Manager
Setup Options dialog box.

■ Any change you make to an option in the Desktop Manager overrides the corresponding
setting you may have made on the MultiPASS device itself.

Therefore, before you make changes to these option settings, decide where you prefer to make
your changes — on the MultiPASS or in the Desktop Manager. Establishing a preference for
changes will help you avoid inadvertently overriding your previous settings.
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n
When the MultiPASS is connected to your PC, we recommend that you use the Fax Setup in the
Desktop Manager. Do not make your changes using the operation panel of the MultiPASS.

The following instructions summarize the overall procedures for changing MultiPASS setup
options in the Desktop Manager. For additional detailed information, refer to later sections in
this chapter.

To change setup options in the Desktop Manager:
1. On the Setup menu, click Fax Setup.

2. In the Fax Setup dialog box, click the appropriate tab.

3. On the appropriate setup tab, specify your changes.

4. To save changes and close the dialog box, click OK. When prompted, select whether or not
you want to overwrite the settings on your MultiPASS.

To exit the dialog box without saving your changes, click Cancel.

When you save your changes, MultiPASS setup options are saved in the Desktop Manager, as
well as on the MultiPASS.
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Setting Up Fax Preferences
You can change the following options on the Preferences tab.

■ Date Format
You can select the format used to display the date on the MultiPASS LCD and for printing
the date on a fax.

■ Display Language
You can select the language to be used on the MultiPASS LCD.
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■ Telephone Attached to Unit
If you have a telephone connected to your MultiPASS, select this option. When selected,
you can use the Desktop Manager to dial a phone number and place a phone call with your
telephone.

When you select this option, the Phone command (in the File menu and toolbar) becomes
available in the Desktop Manager.

■ Volume
You can set the volume level of the various sound components of your MultiPASS, to best
suit your office environment.

■ Color Copy Media
Click the type of paper you will be using in your MultiPASS to copy color images and
documents. This option enables your MultiPASS to optimize the quality of the copy
produced based on the type of paper being used.

■ Bottom Margin
Click the size of the margin to be used on the bottom of your paper for printing color faxes
you receive. Selecting a smaller margin may ensure that the bottom edge of your fax prints
properly.

■ Print Activity Report
Select this option to have the MultiPASS automatically print an activity report after every
20 faxes sent and received. If this option is cleared, an activity report is not printed.
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Setting Up Send Fax Options
You can change the following options on the Send Fax tab.

■ Fax Information
You can specify the following information to appear as the header for a PC fax: your name,
company name, and your fax number. Initially, this information was set up when you
installed the Desktop Manager.
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■ Phone Line
You can specify the dialing method the MultiPASS uses: touch tone or rotary pulse. You can
also specify any prefix used to access an outside phone line (usually 9).

■ Automatic Retries
You can specify the number of retries the system should attempt when sending a fax
transmission, and the length of time between each retry.

■ Automatic Report
You can specify whether or not you want a report to print with each fax transmission, or
only when there is an error.

You can also specify if you want an image of the first page of the fax included in the report.
This feature is applicable only for black and white faxes sent manually with the MultiPASS,
and not for faxes sent with your computer or color faxes.

Restoring the Default Settings

If you want to restore the option default settings after making changes, click Use Defaults.
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Setting Up Advanced Send Fax Options
You can change the following options by clicking Advanced on the Send Fax tab.

■ Speed
You can set the transmission speed used to send faxes. The higher the setting, the faster the
transmission. If you experience problems when sending faxes, try a lower speed setting.

■ Pause Duration
You can set the length of the pause that you may have to insert when dialing a long distance
number.
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■ Error Correction (ECM)
You can select this option to reduce system and line errors when sending a fax. With this
option selected, the system checks each outgoing fax for lost data. If data has been lost from
a portion of a page, the system transmits that portion again after confirming that all data
within that portion can be transmitted successfully.

■ Auto Start Send
When you select this option, the unit starts scanning automatically if you press a speed dial
number, or when you enter a destination and press the Start/Scan button. When you don’t
select this option, you must press Start/Scan twice to scan the document.

■ Off Hook Alarm
You can select this option to turn on the alarm after the MultiPASS has received or sent a
fax if the telephone is off-hook.

■ Contrast
You can select a setting that determines the level of contrast in the faxes you send. The
Standard setting is usually appropriate for most documents. However, based on the
lightness or darkness of your original fax document, you may prefer to lighten or darken
the contrast for the fax transmission.

■ Position
You can select where you want the sent fax heading information (your fax number, your
name, and date and time) to print on the faxes you send. This information is known as the
Transmit Terminal Identification (TTI).
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■ Mark Faxes With
Select how you would like to identify the fax/phone number in the header of a fax you
send. For example, if you typically use the designated number for phone calls rather than
sending faxes, you can identify the number as a telephone number. Otherwise, identify the
number as a fax number, used primarily for sending and receiving faxes.

Setting Up Receive Fax Options
You can change the following options on the Receive Fax tab.
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■ Paper Size
You can select the size of the paper you are using for printing a fax.

■ Reduce to Fit Paper
You can specify whether you want an incoming fax reduced to ensure the contents fits on
the paper on which it is printed. If you want to reduce the incoming fax, you can fit to
height only, or both the height and width, to fit the paper size.

■ Answer Receive Mode
You can select the mode by which you want the MultiPASS to receive incoming calls:

� Fax/Tel Mode
Automatically switch for receiving a call either as a fax or telephone call

� Fax Only Mode
Automatically receive only fax calls

� Manual Mode
Require you to manually answer the incoming call, and then set the MultiPASS for an
incoming fax

� Answer Machine Mode
Automatically receive a call with your answering machine
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� DRPD Mode
Automatically switch between receiving a call either as a fax or telephone call based on
the ring tone for each type of call (This setting is applicable only if you subscribe to a
special network service with your phone company that defines multiple ring tones for
your phone line.)

■ Answer Silent Receive
You select this option to set the MultiPASS not to ring for an incoming fax.

■ Answer Number of Rings
If you cleared the Silent Receive option, indicating you want the MultiPASS to ring for
incoming fax calls, you specify the number of times the MultiPASS should ring for the fax
call. The MultiPASS only rings if you have connected a telephone.

■ Receive Conditions
You can specify how the system should handle an incoming fax under the following
conditions:

� If your computer is turned off:
You set the MultiPASS to print the fax or save the fax in its memory.

� If your computer is turned on:
You set the MultiPASS to move the fax to the Desktop Manager on your computer, or
to print the fax.
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� If your MultiPASS is not ready:
If you set your MultiPASS to print incoming faxes, rather than to send them to your
computer, select how you want to handle faxes if the MultiPASS is not ready (for
example, if the printer is out of paper).

If you choose to receive the faxes into memory, the incoming faxes are saved until you
are able to print them. If you choose to not to receive faxes, only the first fax that
encounters the error is saved. No subsequent incoming faxes are saved in memory.

It is recommended that you set your system to receive faxes into memory.

■ Report Print
You can specify whether or not you want a report to print with each fax reception, or only
when there is an error.

Restoring the Default Settings

If you want to restore the option default settings after making changes, click Use Defaults.
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Setting Up Advanced Receive Fax Options

To change the following Advanced Receive Fax options, click Advanced on the Receive Fax tab.
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■ Speed
You can set the transmission speed used to receive faxes. The higher the setting, the faster
the fax is received. If you experience problems when receiving faxes, try a lower speed
setting.

■ Error Correction (ECM)
You can select this option to reduce system and line errors when receiving a fax. With this
option selected, the system checks each incoming fax for lost data. If data has been lost
from a portion of a page, the system receives that portion again after confirming that all
data within that portion can be received successfully.

■ Ink/Toner Saver
You can select this option if you want to print documents in the Desktop Manager using a
reduced amount of ink, thereby saving printer ink. When using this option, the printed
document may appear to be less bright or contrasted.

■ Listen Time Before Ringing
When a call is received, the MultiPASS checks to see if the call is from a fax machine or a
telephone. If the MultiPASS does not have enough time to detect the fax tone, it assumes
the call is from a telephone. You use this option to set the appropriate amount of time to
allow the MultiPASS to check for the type of call.
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■ Ring Time
When your MultiPASS is set to receive both fax and telephone calls, it rings to inform you
of an incoming telephone call. If you do not pick up the telephone receiver within a certain
amount of time, the MultiPASS stops ringing. You use this option to set the appropriate
amount of time the MultiPASS should ring.

■ Ring Tone
You can set the volume level of the ring tone.

■ Default Action If No Answer to Telephone
You set this option to Receive if you want the MultiPASS to handle an incoming call,
detected as a telephone call that is not answered, as an incoming fax. If no fax is received,
the line is then disconnected. If you set this option to Disconnect, the MultiPASS
automatically disconnects the unanswered call, without switching to try and receive a fax.

■ Enable Reception of Color Faxes
Select this option if you want your MultiPASS to receive color faxes. If this option is
cleared, the MultiPASS does not receive color faxes.

■ Manual/Auto Switch
To prevent missing incoming documents when the MultiPASS is set to manual receiving,
you can set the unit to automatically answer the phone and switch to automatic. The unit
can receive the incoming fax after the specified ring time (the number of seconds you
specify).
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■ Remote Receive
You select this option so that you can set the MultiPASS, from a telephone extension, to
receive a fax if an incoming call is ringing on the MultiPASS. If you select this option, you
must assign a remote identification number that signals the MultiPASS to receive the fax.

■ Remote Identification Number
If the Remote Receive option is selected, you assign the identification number you will use
to set the MultiPASS to receive a fax.

■ DRPD Switch Options
You can select this option if you subscribe to the Distinctive Ring Pattern Detection
(DRPD) service through your phone company. You then specify each ring pattern you have
been assigned, with its associated action, fax ID, and fax number.

When you select this option, the Receive mode is automatically set to receive both fax and
telephone calls.

■ Ring Pattern
If you subscribe to DRPD through your phone company, select the ring pattern assigned to
each phone number by your phone company: Normal (single-ring), Double (double-ring),
S-S-L (short-short-long ring), S-L-S (short-long-short ring), or Other.

■ Action
If you subscribe to DRPD through your phone company, select the call type to be received
for each selected ring pattern. Typically, you would specify telephone calls for one ring
pattern and fax calls for the other ring pattern. However, if necessary, you can specify that a
selected ring pattern switch between receiving telephone and fax calls.
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■ Fax ID
If you subscribe to DRPD through your phone company, enter your name or company
name (or some other fax recipient identification) for each selected ring pattern. This
information is transmitted to the caller’s fax machine and displayed in the caller’s LCD as
verification.

■ Fax Number
If you subscribe to DRPD through your phone company, enter the phone number assigned
for receiving a call for each ring pattern. This information is transmitted to the caller’s fax
machine and displayed in the caller’s LCD as verification.

Setting Up Speed Dial Assignments
On the Speed Dial tab, you can set up fax numbers for speed dialing with the MultiPASS. You
use the fax recipients set up in your Address Book, assigning the desired individual to speed dial
codes. If the recipient has not yet been set up in the Address Book, you can add the recipient
while creating speed dial assignments. You can also set up a group speed dial, by assigning two
or more individual speed dial assignments to a single speed dial assignment.

For reference, you can print the list of speed dial assignments to display near the MultiPASS.
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Assigning an Individual to a Speed Dial Code

To assign a fax recipient to a speed dial code:
1. In the Address Book list box, select the recipient that you want to assign to a speed dial

code.

2. Select the speed dial code to which you want to assign the recipient, and click Add.

To remove a recipient from a speed dial code:
In the speed dial list box, select the speed dial assignment, and then click Remove.
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To print the speed dial assignment list:
Click Print List.

Because of the width of the columns on the list, the first and last names of an address book
entry may not fully appear.

To add a recipient to the Address Book:
1. Click New.

2. In the New Individual Entry dialog box, complete the appropriate information for the
recipient and then click Add. For detailed instructions on completing the New Individual
Entry dialog box, refer to Chapter 3, PC Faxing.

Defining a Group Speed Dial Code

This section provides instructions for assigning two or more recipients to a speed dial code.

1. On the Speed Dial tab, make sure the desired recipients for your group are set up as
individual speed dial assignments.

2. Select the speed dial code to which you want to assign the group of recipients, and click
Group Dial.
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3. In the Group Dial dialog box, in the Group Name box, enter a name for the group
assignment.

4. In the Speed Dial list box, select the first recipient and click Add. Repeat this procedure
until the desired recipients are included in the Members list.

5. To remove a member from the group, select the member in the Members list and click
Remove.

6. When all the desired members are listed in the Members list, click OK to save your group.

To close the dialog box without saving your group, click Cancel.
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Setting Up System Options
The Desktop Manager contains system setup options that define certain general operations of
the Desktop Manager.

To set system preferences:
1. In the Desktop Manager, click System Setup on the Setup menu.

2. In the System Setup dialog box, select the option you want to use.
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� Include Annotations On
You can specify what documents you want to display, or hide, document annotations:
on printed pages, e-mail attachments, files exported to Windows, or sent faxes.

� E-Mail Attachments
You can specify the format you want to use for color and monochrome document
e-mail attachments, such as BMP, JPG or TIF.

� Confirm Before Deleting
Select Confirm Before Deleting to display a confirmation message before deleting a
document.

� Automatic Indexing
Select Automatic Indexing to enable the Desktop Manager to automatically index your
documents based on the text within the documents.

3. To save your changes, click OK. To close the dialog box without saving your changes, click
Cancel.
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Using the Launcher
The Desktop Manager Launcher enables you to display a Desktop Manager document in
another application in a specified file format. For example, dragging a document from a folder
in the Desktop Manager to the Paint icon starts the Paint application and displays the selected
document in a BMP file format.

When you launch a document, a copy of the document appears in the application with a
system-assigned name. If you save the document, it is saved with the system-assigned name in
your C:\Windows\Temp folder. If you want to give the document a more meaningful name, use
the Save As command. Any modifications made to the document are made to the copy, and not
the original document stored in the Desktop Manager.

You can also start an application (without displaying a document) by simply clicking on the
application icon in the Launcher.
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To display a document in another application with the Launcher:
Drag the document from a folder in the Desktop Manager onto an application button in the
command bar.

To start another application with the Launcher:
On the command bar, click the application button.

Adding Applications to the Launcher

If you have another application that you would like to start from the Desktop Manager, you can
add the application to the Launcher. You can add any application by adding its executable file
(EXE) to the Launcher.

To add an application:
1. In the Desktop Manager, click Launcher Setup on the Setup menu.
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2. In the Launcher Setup dialog box, select the next Empty location in the list, and then click
Edit.

3. In the Edit Launcher Item dialog box, in the Program File box, enter the path and file name
for the application EXE file.

To locate a file, click Browse. In the Browse dialog box, select the path and EXE file you
want to add to the Launcher, and then click Open.

4. In the Edit Launcher Item dialog box, in the File Type Conversion list, select the file type in
which you want documents to appear.

5. Click OK to close the Edit Launcher Item dialog box.

6. Click OK to close the Launcher Setup dialog box and add the application to the Launcher.
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Modifying the Launcher Setup

As needed, you can modify the setup of the applications in the Launcher. You can:

■ Change the sequence in which the applications appear in the command bar.

Applications appear from left to right in the command bar, based on the order they appear
in the Launcher setup list.

■ Edit the Launcher setup properties for an application (such as the file type).

■ Delete an application from the Launcher.

To edit the Launcher setup for an application:
1. In the Desktop Manager, click Launcher Setup on the Setup menu.

2. To rearrange the order of the Launcher application buttons on the command bar:

In the Launcher Setup dialog box, select the application in the list and click Move Up or
Move Down. The application is repositioned in the list, thereby determining the order on
the command bar.

3. To change the application setup properties:

In the Launcher Setup dialog box, select the desired application, and then click Edit.

In the Edit Launcher Item dialog box, as desired, change the path and name for the
program file and the assigned file type. Then click OK.
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4. To delete an application from the Launcher:

In the Launcher Setup dialog box, select the desired application, and then click Delete.

5. Click OK to save your changes and close the Launcher Setup dialog box.

Making a Phone Call From the Desktop Manager
You can use the MultiPASS and Desktop Manager to dial telephone calls if:

■ You have a telephone connected to the MultiPASS.

■ You selected the Telephone Attached to Unit option on the Preferences tab in the Fax Setup
dialog box in the Desktop Manager.

You can place a call to any individual you want, whether or not the individual has been set up in
the Address Book. At the time you are attempting to make your call, you can also set up an
individual in the Address Book.

To place a phone call from the Desktop Manager:
1. Click Phone on the File menu or toolbar.
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2. In the Phone dialog box, enter the phone number you want to call, or select an Address
Book entry.

When you enter the phone number, you use the applicable numeric characters and any
valid characters that separate the different segments of the phone number. For example,
you can use 0 through 9, dash (–), or parentheses (). Other characters are also available for
entering a phone number. For a complete list of the characters that are valid in the Desktop
Manager, refer to Appendix A.

3. To add an individual to the Address Book, click New Individual and complete the
Individual Entry dialog box. For details on completing the Individual Entry dialog box,
refer to Chapter 3, PC Faxing.

4. With the phone number entered or selected, click Dial.
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5. When the Dialing Phone dialog box displays, you are prompted to pick up the extension
telephone receiver.

6. When you have completed your call, click Exit.

Using the MultiPASS Status Monitor
The MultiPASS Status Monitor is required for controlling and tracking the current status of the
MultiPASS, incoming and outgoing faxes, print and scan jobs, and any error conditions needing
your attention.

With the installation of the MultiPASS software, the Status Monitor is set up to start auto-
matically when you log into Windows. When started, the Status Monitor displays as an icon in
the Windows taskbar or as a window.

n
It is recommended that you keep the Status Monitor open while your computer is on and the
MultiPASS is connected. The Status Monitor must be open for you (and any shared users) to
use your MultiPASS with your computer.
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To start the Status Monitor:
On the Windows desktop: Click Start, and then point to Programs. On the Programs menu,
point to MultiPASS Suite, and then click MultiPASS Status Monitor.

Using the Minimized Status Monitor

The minimized Status Monitor appears as an icon in the Windows taskbar. The graphical
appearance of the icon depicts the type of activity it is reporting. For example, the scan graphic
is used to depict the status of scan activity.

You can display a menu enabling you to perform certain tasks, such as open the Status Monitor
window and open the Desktop Manager.

To display the menu on the minimized Status Monitor:
Right-click the MultiPASS Status Monitor icon.

To open the Status Monitor window from the icon:
Click Restore on the Status Monitor menu.
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To open the Desktop Manager from the Status Monitor icon:
Click Go To Manager on the Status Monitor menu.

To specify the Status Monitor as the top window:
Click Always On Top on the displayed menu.

To reconnect the printer (if previously disconnected):
Click Reconnect on the Status Monitor menu.

To display the port on which the MultiPASS is connected:
Click Device Information on the Status Monitor menu.

To start the Status Monitor when you start Windows:
Click Load on Windows Startup on the Status Monitor menu.

To close the Status Monitor:
Click Close on the Status Monitor menu.
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Using the Status Monitor Window

The Status Monitor window displays the status of MultiPASS activity only. You cannot use the
MultiPASS Status Monitor to interrupt an activity.

You can display a menu in the Status Monitor window that enables you to perform certain
tasks, such as close the window and return to the minimized MultiPASS Status Monitor, open
the Desktop Manager, and close the MultiPASS Status Monitor.

To display the menu on the MultiPASS Status Monitor window:
Click the right mouse button in the MultiPASS Status Monitor window.

To open the Desktop Manager:
In the window title bar, click the Desktop Manager button. Or, click Go To Manager on the
Status Monitor menu.

To specify the Status Monitor as the top window:
Click Always On Top on the Status Monitor menu.

To reconnect the MultiPASS and Desktop Manager (if previously disconnected):
Click Reconnect on the Status Monitor menu.
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To display the port on which the MultiPASS is connected:
Click Device Information on the Status Monitor menu.

To return to the MultiPASS Status Monitor icon:
Click Minimize on the Status Monitor menu.

To start the Status Monitor when you start Windows:
Click Load on Windows Startup on the Status Monitor menu.

To close the MultiPASS Status Monitor:
Click Close on the Status Monitor menu.

Status Messages

The MultiPASS Status Monitor reports the following statuses for the MultiPASS.

■ Idle
This status indicates the MultiPASS is currently inactive.

■ Scanning
This status indicates the MultiPASS is scanning an image. The Status Monitor window
displays the number of the page currently being scanned.

■ Printing
This status indicates the MultiPASS is printing a document.
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■ Sending Fax
This status indicates the MultiPASS is sending a fax document. The Status Monitor window
displays the number of the page currently being faxed.

■ Receiving Fax
This status indicates the MultiPASS is receiving a fax document. The Status Monitor
window displays the fax number or name of the sender (if available), and the number of
the page currently being received.

■ Attention Needed
This status indicates the MultiPASS needs your attention for situations, such as the
MultiPASS being out of paper. The Status Monitor window describes the nature of the
attention required. When you have corrected the situation, the status message
automatically clears.

■ Error Warning
This status indicates the MultiPASS has a problem that needs your more immediate
attention, such as when the Status Monitor can no longer detect the MultiPASS. The Status
Monitor window displays the nature of the problem, with a comment indicating a
corrective action. When you have corrected the situation, the status message automatically
clears.

■ Downloading User Settings
This status indicates that the Desktop Manager is saving setup information to the
MultiPASS, overriding the information you may have set manually on the MultiPASS.
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Disconnecting the MultiPASS
You can disconnect the MultiPASS if you want to use the parallel port for another purpose.

The MultiPASS system automatically detects if a different device is connected to the port, and
stops any communication between the MultiPASS and Desktop Manager. Later, when you
reconnect the MultiPASS, you must restart the communication between the MultiPASS and the
MultiPASS system on your computer.

To disconnect the MultiPASS:
1. Turn off your computer.

2. Unplug your computer from all electrical sources.

3. Unplug the MultiPASS from all electrical sources.

4. On the back of your computer, remove the cable connector from the parallel printer port.

5. On the MultiPASS, release the wire clips and remove the cable connector from the port.

6. Plug your computer back in to the electrical source.

n
If you restart the computer and the MultiPASS is not connected, you will see a “Hardware
could not initialize” error message. Click OK to the message and select close from
the Status Monitor menu.
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Restarting the MultiPASS Connection

If you reconnect the MultiPASS to the port and want to begin using the Desktop Manager again,
the connection between your MultiPASS and MultiPASS system automatically restarts when you
restart your computer. You can also restart the MultiPASS connection without restarting your
computer.

To restart the MultiPASS connection without restarting your computer:
1. If you are using Windows NT, restart the MultiPASS Service. (For details, see your Windows

NT documentation.)

If you are using Windows 98 or Windows 95, skip to Step 2.

2. If not currently open, open the MultiPASS Status Monitor window.

If the MultiPASS Status Monitor is already open, display the Status Monitor menu and click
Reconnect.

n
The Reconnect button will be active is the printer cable is connected to another parallel port
device while the Status Monitor is running.
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Removing the Desktop Manager
If you are planning on reinstalling the MultiPASS Desktop Manager, you must first remove the
current installation of the software.

n
If you are using Windows NT, you must log on as Administrator or have Administrator
privileges to remove the Desktop Manager software.

When you remove the software, you remove the MultiPASS Desktop Manager, and related
printer, fax, and scan drivers. You do not need to remove the database. So that you can reinstall
the MultiPASS Desktop Manager at a later time and continue to use your data files, address
book, cover page templates, and so on, the following items are not removed automatically:

■ MultiPASS directory

■ Data folders and files
(such as Fax Log and Address Book)

■ System files shared with other applications.

If you choose to remove the Desktop Manager database during the removal of the Desktop
Manager software, you must also remove the ODBC interface.
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When you remove the Desktop Manager software in Windows NT, the MultiPASS printer and
fax drivers are automatically removed as well. If you are using Windows 98 or Windows 95, you
need to manually remove the printer and fax drivers, and then the Desktop Manager software.

To remove the Desktop Manager:
1. Close the MultiPASS Desktop Manager and all of its components (such as the Send Fax

Manager and MultiPASS Toolbar).

2. Close the MultiPASS Status Monitor and MultiPASS Toolbar.

3. On the Windows desktop, click Start, and then point to Settings.

4. On the Settings menu, click Control Panel.

5. In Control Panel, double-click Add/Remove Programs.

6. In the Add/Remove Programs Properties dialog box, click MultiPASS Suite, and then click
the Add/Remove button.

7. Follow the on-screen instructions.

� When prompted, choose whether or not you want to remove the Desktop Manager
database.

� If you chose to remove the Desktop Manager database, when prompted, choose to
remove the ODBC interface.
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To remove the printer and fax drivers (Windows 98/95):
1. On the Windows desktop, click Start, and then point to Settings.

2. On the Settings menu, click Printers.

3. In the Printers dialog box, select the Canon MultiPASS icon and press the Delete key.

Repeat this step for the Canon MultiPASS fax icon.

To complete the removal process:
Once you have deleted the printer and fax drivers (for Windows 98/95) and the Desktop
Manager, be sure to restart the computer.
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Chapter 7
Frequently Asked Questions

This chapter contains information for questions you may have when operating Desktop
Manager with your MultiPASS.

❑ MultiPASS Cannot Be Initialized ........................................................................................ 7-2
❑ MultiPASS Service Cannot Be Restarted (Windows NT only) .......................................... 7-3
❑ Faxes Are Not Being Sent Correctly .................................................................................... 7-4
❑ Faxes Are Not Being Received Correctly ............................................................................. 7-6
❑ Images Are Not Scanning Properly ..................................................................................... 7-8
❑ Documents Are Not Being Copied ..................................................................................... 7-9
❑ Documents Are Not Printing Correctly ........................................................................... 7-10
❑ Paper Is Not Loading Correctly ........................................................................................ 7-13
❑ The Print Quality Is Not Satisfactory ............................................................................... 7-14
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MultiPASS Cannot Be Initialized
■ Is the operation panel blank?

You might have a power problem. Check that the  power cord is plugged securely into the unit,
and that your electrical source is OK. You should have the MultiPASS connected directly to its
own AC outlet and not connected to a power strip to which your computer is connected.

■ Is the unit set to the correct parallel port?

Make sure that the MultiPASS is configured for the correct parallel port in the Printer
Properties dialog box. Be sure that it is the only device configured to a particular port. The
MultiPASS operates properly only with a dedicated parallel port.  Remove any switch boxes, zip
drives, tape backups, docking stations, or scanners from the parallel port if necessary.  Check
both ends of the printer cable to be sure that it is securely fastened.
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MultiPASS Service Cannot Be Restarted (Windows NT only)
■ Is there a message indicating that the device is not found?

If you receive a message indicating that the MultiPASS device cannot be found, be sure that the
MultiPASS is connected correctly to the port.

■ Is there a message indicating that the device is incompatible?

Be sure the MultiPASS is connected correctly to the port. Then open the MultiPASS Status
Monitor window and display the menu. On the MultiPASS Status Monitor menu, click
Reconnect.

■ Are you unable to start the MultiPASS Service?

Be sure you are logged into Windows with Administrator privileges. You cannot start MultiPASS
Service without Administrator privileges.
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Faxes Are Not Being Sent Correctly
■ Is the operation panel blank?

You might have a power problem. Check that the power cord is plugged securely into the unit,
and that your electrical source is OK.

■ Is the unit set correctly for the type of telephone line in use (pulse/tone)?

If you have a pulse line, be sure the unit is set for pulse dialing. If you are not sure about what
type of line you have, contact your local phone company.

■ Is the MultiPASS warm to the touch?

The unit might have overheated and shut itself off. Turn the unit off and let it cool down for
several minutes. However, faxes in memory will be lost. Try using the unit again.

■ Did a document not feed correctly through the Automatic Document Feeder (ADF)?

Remove the document, stack it, and feed it into the unit again.

■ Are errors being reported when you send a fax?

Make sure Error Correction (ECM) mode is on (see page 6-10). ECM sending or receiving
should help with problems due to poor telephone lines. However, you might have to try again. If
the receiving fax unit does not support ECM transmission, the document is received in the
normal mode without error checking.
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■ Are your faxes failing to be sent?

Make sure your phone line is active and correctly connected to the MultiPASS.

■ Is speed dialing not working correctly?

If you were not able to use one-touch, coded, or group speed dialing, check the contents of the
one-touch or coded speed dialing button and be sure to register it correctly.

■ Is the other party’s fax machine having problems receiving your faxes?

Make a photocopy. If it is clear, the other party’s fax unit might be the problem. Ask the other
party to check the receiving fax unit for:

� Full paper supply

� Whether the fax unit is a G3 machine

� Whether the unit supports ECM (if so, turn ECM on for your MultiPASS).

■ Does the BUSY/NO SIGNAL message appear in the LCD display?

Make sure your phone line is active and correctly connected to the MultiPASS.
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Faxes Are Not Being Received Correctly
■ Is the operation panel blank?

You might have a power problem. Check that the power cord is plugged securely into the unit,
and that your electrical source is OK.

■ Is the MultiPASS warm to the touch?

The unit might have overheated and shut down. Turn the unit off and let it cool down for
several minutes. However, faxes in memory will be lost. Try using the unit again.

■ Is the MultiPASS not switching correctly between telephone and fax transmissions?

Make sure Receive Mode is set to Fax/Tel Mode.

■ Are you not automatically receiving faxes?

Make sure Receive Mode is set to Fax/Tel Mode or Fax Only Mode.

■ Are you not manually receiving faxes?

Always press Start/Scan before hanging up the extension telephone receiver (not after).
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■ Are you receiving faxes but the faxes have errors?

In the Advanced Receive Fax setup options dialog box, in the Desktop Manager, select the Error
Correction (ECM) option. ECM sending or receiving should help with problems due to poor
telephone lines. Enable ECM and try again. If the sending fax unit does not support ECM
transmission, the document is sent in the normal mode without error checking.

■ Is a received fax not printing?

Your BJ cartridge might be out of ink. Change the BJ cartridge or the ink tank. Check your
paper supply. Be sure you are using paper that meets the paper requirements for this unit.

■ Is the quality of the received fax poor?

Remember, the sending fax machine usually determines document quality. Print a self test. If
the print quality is good, ask the other party to check that their top cover and scanning glass are
clean.

■ Does the MultiPASS continue to ring if you pick up a voice call with another phone?

The MultiPASS printer does not recognize an extension phone connected to another phone jack
(that is, a phone connected to the same phone line, but not connected to the MultiPASS).

If a call comes in and you pick it up with an extension phone not connected to the MultiPASS,
the MultiPASS continues to ring for a time, checks for a fax, and then disconnects.
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Images Are Not Scanning Properly
■ Are you having problems scanning an image with your TWAIN-compliant Windows

application?

If you installed the TWAIN-compliant Windows application after installing the Desktop
Manager, there may be a problem with the TWAIN system files that were overwritten. To correct
the problem, reinstall the Desktop Manager software.

■ Is scanning an image very slow?

If you change the parallel port on your computer to ECP (Extended Capabilities Port), scanning
speed and throughput increases.

For details on using ECP, refer to your user documentation or contact your computer
manufacturer.
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Documents Are Not Being Copied
■ Is the operation panel blank?

You might have a power problem. Check that the power cord is plugged securely into the unit,
and that your electrical source is OK.

■ Is the MultiPASS warm to the touch?

The unit might have overheated and shut down. Turn the unit off and let it cool down for
several minutes. However, faxes in memory will be lost. Try using the unit again.

■ Are you not able to make copies?

The telephone receiver might be out of the cradle. Make sure the receiver is in its cradle.



Chapter 7 Frequently Asked Questions    7-10

Documents Are Not Printing Correctly
■ Is the operation panel blank?

You might have a power problem. Check that the power cord is plugged securely into the unit,
and that your electrical source is OK.

■ Is the MultiPASS warm to the touch?

The unit might have overheated and shut down. Turn the unit off and let it cool down for
several minutes. However, faxes in memory will be lost. Try using the unit again.

■ Is the Alarm light on?

Turn off the MultiPASS unit. Wait 15 seconds and plug it in again to turn on power. The Alarm
light should go out. Also check to see if paper is jammed.

■ Does the MultiPASS LCD display read “Check Paper Size”?

If you are printing from a Windows application, the print setup options may be conflicting.
Make sure that the selected paper sizes correspond in the following:

● MultiPASS paper feeder
The paper in the MultiPASS multi-purpose tray must be the same size as the settings you
have selected.
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● Desktop Manager
In the Desktop Manager, on the Setup menu, click Fax Setup. On the Receive Fax tab, make
sure the correct size is selected from the Paper Size list.

● Windows application you are using
In the Windows application, in page or print setup, make sure the correct paper size is
selected.

If the MultiPASS LCD display still reads Check Paper Size, access the MultiPASS properties
from the Windows desktop. In the Canon MultiPASS Printer Properties dialog box, select the
Paper tab. Make sure the correct paper size is illustrated in the Selected Paper box.

■ Does paper not come out of the printer?

Check that you have a bi-directional parallel cable connecting the MultiPASS unit to your PC.
Check your computer’s setup to be sure the primary parallel port is set to the appropriate
printer port, for example, LPT1 or LPT2. Make sure the Print Setup option of your printing
application shows Canon MultiPASS Printer as the printer selected.

■ Is the printing not fast enough?

The print options you have selected might be too complex. Set print options to the basics, such
as standard quality, automatic print model, and so on. Also, close all unnecessary applications
and delete all temporary files.
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■ Does the job not print when using DOS?

The MultiPASS printer driver was designed to print documents in Windows.

■ Is the document printing with undesirable results?

You may experience undesirable results when printing a document if you have the Windows
Printing System (or other bi-directional device, such as a later model laser printer) installed on
your computer and you are attempting to use the same port on which you also have the
MultiPASS connected. Be sure that the MultiPASS is the only device configured to a particular
port. The MultiPASS operates properly only with a dedicated parallel port.

■ Are more copies of the document printing than you expected?

The MultiPASS may print more copies of the document than you expected if: (1) you specify
more than one print copy in the Printer Default dialog box (when setting printer default
properties for the MultiPASS); and (2) you specify more than one print copy in the Print dialog
box (when printing a document using the MultiPASS). The number of copies that may print is
the total of the two print copy settings. For example, if you set the number of print copies in the
Printer Default dialog box to 2 copies, and in the Print dialog box to 2 copies, the MultiPASS
may print 4 copies.
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Paper Is Not Loading Correctly
■ Does paper not load into the unit?

The multi-purpose tray might contain too many sheets or paper might not be inserted all the
way into the multi-purpose tray.

■ Does paper not feed through one sheet at a time?

Be sure to fan the stack of paper before placing it in the multi-purpose tray. Make sure the stack
of paper does not exceed the paper limit mark.

■ Is an envelope not loading correctly?

Make sure you do not stack more than 10 envelopes in the multi-purpose tray.

■ Does paper not feed through the Automatic Document Feeder (ADF)?

If paper jams in the ADF, open the operation panel and remove the document gently; then close
the operation panel.
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The Print Quality Is Not Satisfactory
■ Are some of the characters not printing?

If characters are not printing, check the parallel cable is securely plugged in at both ends; make
sure your parallel cable is less than 6.6 ft (2m). Check your application’s print setup to make
sure Canon MultiPASS Printer is selected as the printer.

■ Do characters not fit on the page?

Make sure paper is aligned correctly in the multi-purpose tray. Check that margins and paper
size are set correctly in your printing application.

■ Is printing not clear?

Check to see if you are printing using the Draft print quality option.

■ Do fonts not print smoothly?

Bitmapped fonts designed for dot matrix printers will not look smooth when printed by high-
resolution printers such as the MultiPASS. Choose another font. Make sure you install an
outline font manager such as Adobe Type Manager or Bitstream Facelift, or that you choose a
TrueType font.
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■ Is the printing not dark enough?

You might be using Draft print quality. Try setting print quality to Standard. Try replacing the
BJ cartridge.

■ Are colors missing or blank pages printing?

You may be running out of ink. Try replacing the BJ cartridge or ink tank.
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Appendix A
Fax/Phone Characters

Whenever entering or setting up a fax or phone number in the Desktop Manager — when
sending a PC fax, setting up an entry in the Address Book, or making a phone call — you use
only the following characters.

Character Description

0 to 9 * # Dialing digits

, p Pause

P Last Pause

T Tone switch over function

+ – ( ) Space Display-only characters. Space cannot be used at the
beginning of a number.
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Glossary

A

Application
Software prepared for a specific function or set of functions. Examples of an application
program include word processing programs and MultiPASS Desktop Manager. Developers who
make application programs include drivers that support different types of printers.

ASCII
Acronym for American Standard Code for Information Interchange. A set of definitions for the
bit composition of characters and symbols. ASCII defines 128 symbols using 7 binary bits and 1
parity bit.

Automatic feed
Method by which paper can be fed into the printer when the built-in paper feeder is used.

B

Bi-directional parallel interface port
An interface connection that is capable of both sending and receiving information. For example,
when you print or send a PC fax from your computer, information is sent from your computer
to the MultiPASS. When you scan or receive a fax into your computer, information is sent from
the MultiPASS to your computer.
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C

Centronics
An interface standard for parallel data transmission. The interface on this unit is a Centronics-
type parallel interface.

D

Default setting
A system setting incorporated at the factory and permanently registered application. Also, a
value or a setting that the software assumes until or unless you specify another value.

dpi
Dots per inch. A unit of measurement for indicating a printer’s resolution.

G

Graphic
A written, printed, or electronically displayed symbol or drawing. Also, characters or text that
have been generated by a computer graphics application program.

Grayscale
A color in black and white as a result of different intensities of black.
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L

Landscape orientation
The horizontal orientation of your document or image across the length of the page. The term
landscape is derived from pictures of the landscape, which are usually horizontal in format.

M

MAPI
Acronym for Messaging Application Program Interface.

P

Paper feed
Movement of a sheet of paper into the printer’s paper path.

PC fax
An electronic way to send and receive faxes from your computer. A PC fax is sent from or
received in a computer. Using the MultiPASS you can send and receive PC faxes and the
MultiPASS Desktop Manager lets you save, sort, and print the PC faxes.

Portrait orientation
The vertical orientation of your document or image across the width of the page (letter style).
This is the opposite of landscape orientation.
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Printer driver
Software that sends printing instructions to a printer. The printer driver keeps track of the
attributes of a printer and the codes a program must send to access those attributes.

T

TWAIN
Both a protocol and an application programmer’s interface (API) that allows you to input
image data directly from any source  (for example: desktop and handheld scanners, video
capture boards, digital cameras, and other imaging equipment) without requiring you to switch
out of the application. It provides compatibility between image input devices and applications
by acting as the liaison between hardware devices and software applications. Because your
MultiPASS supports TWAIN, you can use the scanning features of the MultiPASS with any
Windows application that supports TWAIN. Twain, the industry standard, was developed by the
TWAIN working group which consists of representatives from many leaders in the scanner
hardware and software industry.
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